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E D I T O R I AL

This magazine was created using :

WELCOME TO THE FIRST ISSUE OF FULL CIRCLE FOR 201 5.

W

e're still a man down. I haven't heard from him, so I'm assuming Greg is still ill, so still
no Python this month I'm afraid. In place of Python I've written a quick article on RTLSDR radio. I came across this on YouTube and decided to give it a try. It's amazing what you
can get from a cheap USB dongle. Elmer is here with his usual LibreOffice piece, and closing
off the trinity is an interesting article on how to create an Ubuntu kiosk. By kiosk we mean
the sort of read-only terminal (for want of a better description) that you'd see the public
using for information, or in an internet cafe or something similar.
The Mate desktop originated in Linux Mint, but has since moved over to Ubuntu. Ubuntu
Mate 1 4.1 0 is one of two reviews we have for you this month. The other review is a book
review; The Official Ubuntu Book.
In his lab, Charles takes a first look at FreeBSD. It sounds like he had quite a struggle with
it, but got there in the end. Meanwhile, the kernel series, unfortunately, finishes this month.
There's the first news of the Ubuntu Phone. Canonical have released a statement
discussing their thoughts on phone interfaces, scopes, and much more. The first phones will
be going out to people by mid-February. All going well I'll get my grubby paws on one and
have unboxing, reviews, and thoughts on the beast. Keep your eyes on the FCM site for more
news updates, as and when we get them, from the source; Canonical.

Full Circle Podcast

Released monthly, each episode
covers all the latest Ubuntu news,
opinions, reviews, interviews and
listener feedback. The Side-Pod is
a new addition, it's an extra
(irregular) short-form podcast
which is intended to be a branch
of the main podcast. It's
somewhere to put all the general
technology and non-Ubuntu stuff
that doesn’t fit in the main
podcast.

Hosts:

• Les Pounder
• Tony Hughes
• Jon Chamberlain
• Oliver Clark

All the best to you, and yours, for 201 5!
Ronnie
ronnie@fullcirclemagazine.org

http://fullcirclemagazine.org
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N E WS
FIRST D ETAILS O F THE
U BUNTU PHONE

T

he user experience for
smartphones has revolved
around apps and its icon grid since
the very first iPhone. Key mobile
services on iOS and Android are
delivered via apps in a fragmented
manner and controlled by platform
owners such as Google, Apple and
Microsoft, which has put OEMs and
Operators into a secondary role.

With the Ubuntu phone we are
moving away from the app grid
towards integrated content and
services. And we do this by
providing a user experience that is
centered on bringing the key
mobile digital life services directly
to the screen, which at the heart
we call ‘scopes.’

you’re doing. We’ll go into more
detail on the other aggregated
scopes in an upcoming Phone
Glimpse mailer.

Branded scopes are app like
experiences delivered directly to
the screen, fully branded.
Discoverable through the default
store, from a feed in an
aggregation scope, or as a
Scopes are a way of delivering
favourited default screen. A faster
unified experiences for various
service categories, front and centre way for developers to build a rich
and easier to access branded
to the user, without hiding them
behind a sea of apps and app icons. experience on a device.
They are created via a simple UI
Source: Canonical
toolkit with much lower
Written by: Canonical
development and maintenance
costs than apps. There are two
types of scopes – aggregation and
branded.

Aggregation scopes define the
device’s default experience and
what makes Ubuntu phones
valuable to end users. They allow
OEMs and Operators to create a
user experience that is unique to
Users deserve a richer, faster
and unfragmented experience built their devices such as the NearBy
around the things they do most on scope that aggregates local
services centered around what
their devices.
full circle magazine #93

H OW TO I NSTALL LINUX ON
A CHROMEBOOK AND
U NLOCK I TS FULL
POTENTIAL

T

quite hit their full potential with
Chrome OS. Here's how to install
Ubuntu and get more out of your
Chromebook.
Chrome OS isn't bad, and you
can actually do a lot of work with
the great Chrome apps out there.
But sometimes, you just need a full
desktop to get things done. Enter
Ubuntu: with just a few minutes of
work, you can get a full-fledged
Linux desktop up and running on
some solid Chromebook hardware,
making for a pretty great laptop.
We're going to use a tool called
Crouton to install Ubuntu (hat tip
to our friends at the How-To Geek),
which uses the chroot command to
run Ubuntu on top of Chrome OS,
which is already based on Linux.
Source: http://lifehacker.com/howto-install-linux-on-a-chromebookand-unlock-its-ful-509039343
Submitted by: Arnfried Walbrecht

here are some Chromebooks
with awesome hardware out
there, like the beautiful
Chromebook Pixel – but they don't
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201 5: O PEN SOURCE H AS
WON , B UT I T I SN ' T
FINISHED

A

t the beginning of a new year,
it's traditional to look back
over the last 1 2 months. But as far
as this column is concerned, it's
easy to summarise what happened
then: open source has won. Let's
take it from the top:
Supercomputers. Linux is so
dominant on the Top 500
Supercomputers lists it is almost
embarrassing. The November 201 4
figures show that 485 of the top
500 systems were running some
form of Linux; Windows runs on
just one. Things are even more
impressive if you look at the
numbers of cores involved. Here,
Linux is to be found on 22,851 ,693
of them, while Windows is on just
30,720; what that means is that not
only does Linux dominate, it is
particularly strong on the bigger
systems.
Source:
http://www.computerworlduk.com
/blogs/open-enterprise/opensource-has-won-359231 4/
Submitted by: Arnfried Walbrecht

SAMSUNG TO POWER ALL
FUTURE TVS WITH ITS LINUX
POWERED TIZEN OS

F

or those of you who haven’t
heard what Tizen is - don’t
worry, it is not your fault.
Samsung’s attempt at creating a
Linux-based platform, along with
Intel’s Meego (which died a rather
unfortunate death), hasn’t had the
easiest of rides.
Samsung’s first Tizen
smartphone was postponed
indefinitely, and a later attempt,
the Tizen based- Z1 , had its Indian
launch pushed back from 201 4 to
January 201 5.
Wait, back up. Samsung is
creating a new mobile OS, along
with Intel? Whatever happened to
the infallible (although uneasy)
Android-Samsung partnership?
Easy - Tizen is Samsung’s attempt
to get revenue to flow in their
direction, since the majority of
profits are made by Google in the
current tie-up. Tizen boasts of
being a joint effort of some of the
biggest names in the world - the
directors of Huawei, Fujitsu, NEC,
Panasonic, KT, Sprint, SK Telecom,
Orange, NTT Docomo and
full circle magazine #93

Vodafone sit on the Tizen
Association’s board of directors.

and shortcuts set to the left-hand
side.

Source:
http://thetechportal.in/201 5/01 /01
/samsung-power-future-tvs-linuxpowered-tizen-os/
Submitted by: Arnfried Walbrecht

Source:
http://www.jbgnews.com/201 5/01 /
nokia-lumia-1 020-ubuntu-osfeatures-leaked/233502.html
Submitted by: Arnfried Walbrecht

N OKIA LUMIA 1 020
U BUNTU OS FEATURES
LEAKED

T

here is a fresh leak being
spread throughout the mobile
device world from Team Ubuntu
(via GizmoChina) that appears to
reveal the Nokia Lumia 1 020
smartphone running a full version
of Ubuntu OS Linux. This type of
leak is hard to confirm onehundred percent, but a series of
images within the source website
show the mobile device running
the operating system effectively.
The images appear to reveal the
smartphone running the full
version of the Ubuntu OS desktop
operating system. Anyone who has
used the Ubuntu Linux operating
system previously should recognize
the setup on the phone, as it
featured a basic wallpaper with
tiles commonly used for features

5

B IG YEAR FOR ENTERPRISE
LINUX D ISTROS I NCLUDES
M AJOR U PDATES

P

articularly strong for
enterprise Linux, 201 4 offered
a rare confluence of release timing
calendars. The three major
enterprise Linux vendors delivered
milestone updates in 201 4. On
April 1 7, Ubuntu 1 4.04, codenamed Trusty Tahr, was released as
a long-term support (LTS) version
of Ubuntu. (Ubuntu issues new LTS
releases every two years; each LTS
has up to five years of support.)
Red Hat Enterprise Linux 7 (RHEL)
came out June 1 0, marking the first
major RHEL update for Red Hat
since 201 0. Red Hat supports its
enterprise releases for 1 0 years.
On Oct. 27, SUSE Linux Enterprise
1 2 was released, marking the first
major update to SUSE's flagship
enterprise Linux platform since
2009. Big enterprise Linux releases
contents ^
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were not the only updates during
the year, Red Hat's Fedora
community Linux distribution
delivered Fedora 21 Dec. 9,
providing server-, cloud- and
workstation-focused editions.
Ubuntu 1 4.1 0, code-named the
Utopic Unicorn, which debuted Oct.
23, provides new big data
capabilities
Source:
http://www.eweek.com/servers/sli
deshows/big-year-for-enterpriselinux-distros-includes-majorupdates.html
Submitted by: Arnfried Walbrecht

H ANDS-ON WITH M AKULU
LINUX XFCE 7.0: THE MOST
BEAUTIFUL LINUX DISTRO I

advance standards for the
emerging landscape that is the
Internet of Things (IoT).

Source:
http://www.zdnet.com/article/han
ds-on-with-makulu-linux-xfce-7-0the-most-beautiful-linux-distro-ihave-ever-seen/
Submitted by: Arnfried Walbrecht

Now the AllSeen Alliance is
expanding the framework with the
AllJoyn Gateway Agent that
expands the footprint of IoT
features beyond a user's local
A less expensive version with
environment, all the way out to the
Ubuntu pre-installed will also be
cloud.
available. It’ll sell for just $89, but
the hardware will be stripped
Source:
http://www.datamation.com/cloud- down. The Linux Compute Stick will
have just 1 GB of RAM and 8GB of
computing/linux-foundationallseen-alliance-expands-internet- storage. That’s still plenty of power
for basic computing tasks.
of-things-efforts.html
Submitted by: Arnfried Walbrecht
Source:
http://www.itworld.com/article/28
66536/intel-compute-stick-will-runlinux.html
Submitted by: Arnfried Walbrecht

HAVE EVER SEEN

T

he latest release of Makulu
Linux has two major things
going for it: first, it is based on
Ubuntu 1 4.04 LTS, rather than
Debian, and second, it uses the
Xfce desktop. Makulu seems to be
doing a tour or rotation of
desktops so perhaps having Xfce
shouldn't be a surprise, anyway.

I NTEL COMPUTE STICK WILL
RUN LINUX

The Release Announcement /
Release Notes give some
interesting insight into the
background and development of
this release, as well as the major
features of this release. As always
with Makulu Linux, aesthetics was a
major focus, and it includes loads
of beautiful wallpapers, themes,
icons and fonts. The other major
focus was speed, thus the choice of
Xfce for the desktop, and Firefox
rather than Chrome, the synapse
launcher rather than slingscold,
and the inclusion or omission of
various other packages.

LINUX FOUNDATION
ALLSEEN ALLIANCE
EXPANDS I NTERNET OF
THINGS EFFORTS

T

he AllSeen Alliance today
announced new initiatives and
momentum in its bid to help
full circle magazine #93

The AllSeen Alliance is a multistakeholder effort that is operated
as a Linux Foundation
Collaboration project. The Linux
Foundation first announced the
AllSeen Alliance effort in
December 201 3, with the AllJoyn
code contribution from Qualcomm
serving as the basis. AllJoyn is a
framework for enabling secure and
seamless connectivity, as well as
access, for IoT devices.
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I

ntel has a cool, new pocket
computer called the Compute
Stick. It hasn't been released yet
but there will be a Linux version as
well as one that runs Windows.
The Compute Stick is actually
strikingly similar to the one made
by Shenzen Apec Electronics that
went on sale in October. Intel is
planning to offer two models
initially. Both will be powered by a
quad-core Atom processor. This
one, which will run Windows 8.1
with Bing and comes with 2GB of
RAM, and 32GB of internal storage,
will sell for $1 49.

contents ^
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3D PRINTER DEV KIT RUNS
LINUX ON NEW M ARVELL
ARM V7 SOC

M

arvell announced the first
Linux-based
hardware/software development
kit for 3D printers, built around a
new, 533MHz “88PA61 20! ARMv7
SoC.
Marvell’s 3D Printer SoC
Solution, also known as the Marvell
88PA61 20 3D Printer Development
Kit, provides a complete reference
kit for turnkey development of 3D
printers, says Marvell. The
hardware platform is built around a
new Marvell 88PA61 20 SoC clocked
to 533MHz. The company did not
offer processor details, but said it
is an ARMv7 compatible processor.
Source: http://linuxgizmos.com/3dprinter-dev-kit-runs-linux-on-newmarvell-armv7-soc/
Submitted by: Arnfried Walbrecht

STEALTHY 'XOR.DD OS'
TROJAN INFECTS LINUX
SYSTEMS, INSTALLS ROOTKIT

A

my smartphone to figure out bill
payments or anticipate paycheck
amounts, mainly. But there was a
time, years ago, when I did use a
calculator for math class and
standardized exams. It was
essential to have one for a period
in high school, and for my friends
who pursued mathematics in
The new threat, XOR.DDoS,
alters its installation depending on college, they could be counted on
the victim's Linux environment and to be carrying one in their
backpacks. What use would a
then later runs a rootkit to avoid
detection. Although a similar trojan calculator with a 3D printed case
and free, open source software
has been spotted in Windows
have in the era of the smartphone?
systems, Peter Kálnai, malware
That’s a good question to ask since
analyst at Avast, said in a
the LibreCalc is a new open source,
Wednesday interview with
programmable calculator with a
SCMagazine.com that this trojan
downloadable design available
ventures into relatively untapped
now.
territory by targeting Linux
systems.
Source:
http://3dprint.com/36474/3dSource:
http://www.scmagazine.com/malw printed-calculator-librecalc/
Submitted by: Arnfried Walbrecht
are-targets-linux-and-armarchitecture/article/391 497/
Submitted by: Arnfried Walbrecht
newly discovered trojan is
infecting Linux systems and
possibly building up an arsenal of
devices to be used in distributed
denial-of-service (DDoS) attacks,
according to a blog post from
Avast.

LIBRECALC, THE 3D
PRINTED LINUX
CALCULATOR

I

use the calculator function on
full circle magazine #93

G OOGLE ROLLING OUT
CLASSROOM MOBILE APP
FOR STUDENTS, TEACHERS

G

oogle is launching a new
Classroom-branded mobile
app aimed at encouraging digital
collaboration between teachers

7

and students.
Google Apps for Education
counts more than 40 million
students, teachers and
administrators among its user base,
according to the Internet giant's
estimates last fall. Classroom itself
debuted roughly six months ago in
an effort to make Google Apps for
Education simpler for educators to
use.
The available features for
educators include helping students
keep track of upcoming
assignments followed by the ability
for instructors to mark
assignments as "done" upon
completion.
Since launching, more than 30
million assignments have gone
through Classroom, noted Jorge
Lugo, a software engineer on the
Google for Education Classroom
team.
The mobile version of
Classroom, Lugo explained, is
designed to further facilitate
communications between teachers
and students, namely through the
addition of a teacher assignments
page and the ability to archive
classes.
contents ^
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Source:
http://www.zdnet.com/article/goo
gle-classroom-mobile-ios-androideducation/
Submitted by: Rachel King

Submitted by: Silviu Stahie

the time of testing was the 347.09
driver release.

was abandoned.

And really, that's the coolest
Each operating system was up- part of open-source software.
NVIDIA G EFORCE GTX
to-date, and tested with its default Building on the incredible Pencil
970/980: WINDOWS VS.
settings. The same Intel Core i7
program, a new project was born.
4790K
Haswell
system
was
used
for
Pencil2D is under active
BUNTU LINUX
G IT VULNERABILITY CLOSED UPERFORMANCE
both the Linux and Windows
development, and it's a crosstesting. The Seiki 39-inch 3840 x
platform application allowing for a
IN U BUNTU OS ES
frame-by-frame animation
arlier this week, I posted some 21 60 display was used for testing
to
run
many
of
the
OpenGL
sequence to be drawn and
anonical published some
benchmarks showing NVIDIA's
benchmarks at 4K for fully
exported.
details about a Git
Linux Driver Continues Running
vulnerability that has been found
Strong Against The Windows Driver stressing these latest NVIDIA
Source:
and fixed in Ubuntu 1 4.1 0, Ubuntu that also included the open-source graphics cards.
http://www.linuxjournal.com/conte
1 4.04 LTS, and Ubuntu 1 2.04 LTS
Nouveau driver results in the mix
Source:
nt/non-linux-foss-animation-madeoperating systems.
too. However, due to using the
http://www.phoronix.com/scan.ph easy
Nouveau driver, the newest
p?page=article&item=nvidia_maxw Submitted by: Shawn Powers
Each new Git version usually
GeForce GTX 970/980 graphics
ell900_winlin&num=1
lands with security fixes, and the
cards were left out of testing as
same happened with the latest
the open-source driver doesn't yet Submitted by: Michael Larabel
branch. The developers explained
SCOTUS SEEKS D OJ I NPUT
fully support these newer Maxwell
that Git could have been made to
GPUs. In this article though, we're
ON G OOGLE-O RACLE J AVA
run programs if it received
N
ON -LINUX FOSS:
going back to compare the
D ISPUTE
specially crafted changes from a
Windows vs. Linux performance of ANIMATION M ADE E ASY
repo.
these two high-end NVIDIA GPUs at
he clash of the titans over Java
a UHD 4K resolution too.
f
you've
ever
wanted
to
make
an
may end up being heard by the
This is the same issue that
animated
film,
the
learning
curve
Supreme
Court, possibly hinging on
managed to get Linus Torvalds
As with the other end-of-201 4
for
such
software
often
is
really
what the solicitor general has to
upset about the poor condition of Windows vs. Linux benchmarks,
steep.
Thankfully,
the
Pencil
say about it. SCOTUS has asked for
the HFS+ file system.
Windows 7 Pro x64 with all
program was released and,
available system updates was used although basic, it provided a fairly advice on whether the case merits
its attention. "This is going to be a
Source:
and on the Linux side was Ubuntu
simple
way
to
create
animations
on
true 201 5 nail-biter for the
http://linux.softpedia.com/blog/Git 1 4.1 0. The latest NVIDIA Linux
your
computer
(Windows,
Mac
or
industry," said tech analyst Al
-Vulnerabiltiy-Closed-in-Ubuntudriver is the 346.22 driver version, Linux) with open-source tools.
OSes-470022.shtml
while the latest Windows version at Unfortunately, the Pencil program Hilwa. "This is a judgment on what
might constitute fair use in the
full circle magazine #93
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context of software."
The Supreme Court of the
United States on Monday invited
the Obama administration to
weigh in on whether it should hear
arguments in the ongoing dispute
between Google and Oracle over
Java copyrights.

Submitted by: Katherine Noyes

Source:
http://linuxgizmos.com/tinyfanless-mini-pc-runs-linux-on-quadTINY FANLESS MINI -PC RUNS core-amd-soc/
LINUX ON QUAD-CORE AMD Submitted by: Arnfried Walbrecht

SOC

C

ompuLab today unveiled its
latest mini-PC: the “Fitlet.” This
The move is a response to
tiny, fanless x86 architecture
Google's October petition for a
system consumes just 0.22l of
writ of certiorari following a May
volume, and is offered with a
201 4 federal circuit court decision choice of either a quad- or dualin favor of Oracle.
core 64-bit AMD SoC, clocked at up
to 1 .6GHz and accompanied by
Google argued that the code
AMD’s Radeon R3 or R2 Graphics
was not copyrightable under
GPUs. The Fitlet joins CompuLab’s
section 1 02(b) of the Copyright
long standing “FIt-PC” line of
Act, which withholds copyright
fanless mini-PCs, which encompass
protection from any idea,
both x86- and ARM-based designs,
procedure, process, system, or
support both Linux and Windows
method of operation. It also
OSes, and include a specially
argued that the copied elements
discounted series of preconfigured
were a key part of allowing
MintBox mini-PCs – based on a
interoperability between Java and collaboration with the Linux Mint
Android.
project. Non-minty Fit-PC models
familiar to LinuxGizmos readers
Numerous large technology
include the Fit-PC3, Intense PC, and
companies, including HP, Red Hat
ruggedized uSVR based on dualand Yahoo, have filed amicus briefs core AMD G-T40E and G-T46N
supporting Google's position.
APUs, the Intense PC2 based on a
dual-core Intel Core i7, and the FitSource:
PC4 based on AMD’s quad-core GXhttp://www.ecommercetimes.com/ 420CA SoC with Radeon HD 8400E
story/81 573.html
graphics.
full circle magazine #93

I NDIAN G OVERNMENT

instructed numerous state
governments across India to
implement the switchover from
proprietary Windows systems to
BOSS. To facilitate the process, the
government has also consulted a
Chennai-based IT firm to provide
support for the OS.

BOSS is primarily based on
PLANNING TO PUSH
Debian,
is currently maintained
HOMEGROWN ‘BOSS’ LINUX by C-DACand
(Centre for Development
AS I NDIA’ S OFFICIAL OS
of Advanced Computing). Intended

B

OSS (Bharat Operating System
Solution) is a free software OS
developed by the National
Resource Centre for Free/Open
Source Software (NRCFOSS) under
the direction of the central
government of India. While it has
been around for quite a while, lack
of enthusiasm among the
government officials and common
users all over the country
prevented a high adoption rate of
the OS. However, the new NDA
government at the centre, voted to
power last year, intends to change
that.
Under the Make in India
initiative envisioned by Prime
Minister Narendra Modi, DeitY
(Department of Electronics and
Information TechnologY) has

9

to become a fully-fledged
alternative to Microsoft Windows
systems, BOSS flexes its muscles
when it comes to localization. It is
currently distributed in 1 9
languages. The last stable version,
codenamed Anokha, is itself quite
old by now (released in December,
201 3), but this new push by the
government, coupled with live
technical support and
maintenance, is certain to breath
new life into what is called ‘India’s
homegrown OS’.

Source:
http://computer.financialexpress.c
om/news/governments-boss-movenow-a-homegrown-system-to-runcomputers/7764/
Submitted by: Anirban Chatterjee
contents ^
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M INTB OX M INI : COMPACT
LINUX M INT PC COMING
SOON FOR $295

L

ike several other fitlet models,
the MintBox Mini features an
AMD A4-6400T Micro processor
based on AMD’s Mullins
architecture. It has a Radeon R3
graphics processor, two USB 3.0
ports, 2 USB 2.0 ports, dual HDMI
ports (for up to two displays), a
microSD card reader, and a headset
jack.

Submitted by: Arnfried Walbrecht

U BUNTU LINUX IS NOW

READY TO POWER YOUR
APPLIANCES AND ROBOTS

U

buntu Linux has spread to
quite a few platforms in its 1 0year history, if not always
successfully. Today, though, the
open source software is tackling
what could be its greatest
challenge yet: the internet of
things. Canonical has released a
version of its stripped-down
The computer also features
snappy Ubuntu Core for connected
80.21 1 /b/g/n WiFi and Gigabit
devices like home appliances,
Ethernet and this model will ship
robots and anything else where a
with 4GB of RAM and a 64GB solid conventional PC operating system
state drive.
wouldn't fly. It's designed to run on
modest hardware (a 600MHz
The MintBox Mini should be
processor will do) and provide easy
available in the second quarter of
updates, all the while giving gadget
201 5 for $295 in the US or €295 in makers the freedom to customize
Europe (VAT is included in the
the software for whatever they're
European price). Part of the money building. It promises to be extrafrom sales will help support
reliable, too -- it only applies
development of Linux Mint
updates if the code checks out, so
software, and the MintBox Mini will you won't lose control of your
feature a 5-year warranty.
smart thermostat due to a buggy
upgrade.
Source:
http://liliputing.com/201 5/01 /mint Source:
box-mini-compact-linux-mint-pchttp://www.engadget.com/201 5/0
coming-soon-295.html
1 /20/snappy-ubuntu-core-for-iot/
full circle magazine #93

Submitted by: Arnfried Walbrecht

CERN AND NI
COLLABORATE TO D EFINE
THE FUTURE OF LAB VIEW
SUPPORT FOR LINUX 64-B IT

N

I (Nasdaq: NATI), the provider
of solutions that enable
engineers and scientists to solve
the world’s greatest engineering
challenges, announced a
collaboration with CERN, an
intergovernmental research
organization building the world’s
largest and most advanced
scientific instruments. The
objective is to push the
standardization of all CERN control
systems to Linux 64-bit OSs, with
goals to boost system
performance, design cost-effective
distributed control systems and
enlarge opportunities for small and
medium enterprises with expertise
in NI and open-source
technologies.

the universe is made of and how it
began. Notable collaborations
include the Large Hadron Collider
collimation system, where
applications developed with
LabVIEW system design software
control stepping motors on
approximately 1 20 NI PXI systems,
and the MedAustron ion beam
cancer therapy center, for which
CERN received three awards at
NIWeek 201 3. These common
developments have resulted in
valuable training for engineers in
the fast-growing embedded
systems market, and have led to
long-term maintainable systems in
mission-critical applications.
Source:
http://www.businesswire.com/new
s/home/201 501 2600641 4/en/CER
N-NI-Collaborate-Define-FutureLabVIEW-Support
Submitted by: Arnfried Walbrecht

NI has been working with the
European Organization for Nuclear
Research, more commonly known
as CERN, since the early 1 990s on
applications that help explain what

10
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C O M M AN D & C O N Q U E R

Written by Lucas Westermann

B

small list of settings. The setting
use tells it what stylus plugins to
call (in my case, I am using only
Jeet for the Jeet Framework).
Compress, as you might imagine,
EXAMPLE REPOSITORY
controls the setting for
compressing files (minifying the
The repository can be found on THE APP TASK
CSS). The sourcemap array controls
GitHub here:
a few settings for creating a source
https://github.com/lswest/FCM93This task is intended to compile map file as well, so that the
Gulp-Example
preprocessor CSS files into CSS - I
browser inspector gives you line
WHAT’S THE DIFFERENCE?
use it for stylus, but the same idea numbers relevant to the original
G ULPFILE.JS
applies to SASS and Less (so long as stylus file, as opposed to
The difference between Gulp
you have the correct packages
referencing the minified CSS file.
and Grunt is mainly in their
This is the file that creates and
installed).
This is useful for developing, but
approach to the running of tasks.
organizes the tasks Gulp is
can be left out if you’d prefer.
Grunt focuses on a configurationsupposed to run. The first 7 lines of
The task starts with first
based system where you define
the file (the var name =
running gulp.src - which tells it
Last but not least,
each task’s configurations (files,
require(‘name’);) simply initialize
where to find the stylus file(s). It
.pipe(gulp.dest('./css/')); sets the
compression, plugin to use, etc).
the various Node.JS packages you should be possible to concatenate destination folder for the created
Whereas Gulp focuses on a
need. These need to have been
or use an *.styl call to open all
files.
streaming workflow - that means
installed with npm first – if you
stylus files. As, however, the best
one plugin for one task (no
have your package.json file, simply practice is to reduce the number of
Hopefully by now the term
overlap), and is more
running npm install will be
css files a site has to call, using only “stream-based” is making more
programmatic than configuration- sufficient.
one stylus file to compile is best.
sense. Each function call has one
based. This means the Gulp tasks
Use the @import function to
purpose, and it’s strung together
look more like a JavaScript
The reason why you place the
include other stylus files, so that
one step at a time (into a stream),
function that uses a series of
extensions into variables is to make there is only one resulting CSS file. until you have your final result.
callback functions with each
calling them easier, and the reason
configuration step. It may be easier they’re required is to enable the
Afterwards, there’s a pipe
THE ‘U GLIFY’ TASK
to see the difference by simply
usage of npm packages like Stylus function called on the .src, where
covering how Gulp works. If you
from within gulp.
the stylus function is called with a
The idea behind this task is to
full circle magazine #93
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ack in issue 87, I introduced
readers to Node.JS and the
task runner “Grunt”. I recently
discovered an alternative called
Gulp, which appeals to me a bit
better (more on that soon). Around
the same time, a reader asked if I
could cover Gulp in C&C. So here it
is.

want a presentation on the
differences, see the further
reading section.

G u lp

In the example file, I then create
two tasks. The ‘app’ task starts on
line 9 and runs to line 21 . The
‘uglify’ task is on lines 23-28. The
names of the tasks are arbitrary.

COMMAND & CONQUER
concatenate all JavaScript files,
and then minify the result. This
makes it much less humanreadable, but reduces the file size
and the number of external files a
website has to use. Hence the term
“uglify”.
This task begins again with a
gulp.src function call (that selects
all js files in the folder “js”).
After that, it calls three pipe
functions. The first one
concatenates (combines) all the js
files, then runs the uglify function
(minifying the resulting merged
javascript). The last step, as always,
is a dest function call, defining the
destination of the resulting file.

THE LAST LINE
When defining the tasks we
need, the last line creates one last
task, that I’ve called ‘default’ which
runs both of the other functions
when called. This way, instead of
calling the tasks separately, it
actually completes the entire
process in one fell swoop. The task
is called ‘default’ because that’s
the automatic function called by
gulp.

The end result will be two new
files - one minified CSS file, and
one minified javascript file. Include
these in your HTML head area, and
you’re all set.
I hope that this article has
helped make Gulp look appealing
to anyone who was daunted by
Grunt in the past. There are various
articles on how to use gulp for
other typical tasks (such as using it
for SASS). As the syntax is (in my
opinion) easier to read than Grunt,
if you have any experience with
JavaScript, it should prove easier
to use for beginners. There are
some who find task runners to be
overly bloated for what it should
do. However, the ease-of-use for
some cases (especially for those
starting out) should outweigh the
trade-offs. For those wanting to
use npm and reduce bloat, you can
simply install the raw packages
(such as stylus). To automate
things, you can also create a make
file or a script to execute the
commands. I leave that as an
exercise to the user. If you’re using
a web framework, they generally
have ways of executing function
calls themselves.
If anyone has any questions,
suggestions, or requests, feel free
full circle magazine #93

to email me at
lswest34+fcm@gmail.com.

FURTHER READING
http://markdalgleish.github.io/pres
entation-build-wars-gulp-vs-grunt/
- Presentation on the differences
between Gulp and Grunt.
Gulp website: http://gulpjs.com/

EXTRA! EXTRA!
READ ALL ABOUT IT!
Our glorious news reporters
are now posting regular news
updates to the main Full Circle
site.
Click the NEWS link, in the site
menu at the top of the page,
and you'll see the news
headlines.
Alternatively, look on the right
side of any page on the site,
and you'll see the five latest
news posts.

Lucas has learned all he knows from

repeatedly breaking his system, then
having no other option but to
discover how to fix it. You can email
Lucas at: lswest34@gmail.com.
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Feel free to discuss the news
items. It's maybe something
that can spill back from the site
into the magazine. Enjoy!
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RTL-S D R Ra d i o

Written by Ronnie Tucker

to watch TV on your laptop, but
I haven't heard from him, so I have several people realised that they
to assume Greg is still feeling a bit actually covered a huge spectrum
under the weather this month. Feel of radio frequencies and could be
used for everything from listening
free to email him some get well
to HAM radio, to tracking planes,
soon messages:
and (with the right antennas)
greg.gregwa@gmail.com
downloading weather data from
NOAA satellites. They’re also
known as RTL-SDR devices – RTL
recently stumbled upon a
being a reference to the Realtek
YouTube video showing how
chipset and SDR being Software
easy it was to track planes in realtime using a simple DVB USB stick. Defined Radio.
I decided to purchase one to see if
PREREQUISITES
it really was that easy. And it is!

I

These devices are about
£20/$20 on eBay/Amazon. The one
I have has the Realtek RTL8723BE
chipset. Originally they were made

The first thing you need to do is
add the GQRX PAA to your sources.
This is either done in your package
manager, or in a terminal using:

releases, so, if you have trusty or
lower, then you should be fine. If
you have utopic then you’ll need to
edit your software sources to
change the end of those lines from:
utopic main

to:
trusty main

Now, we need to update the
package list:
sudo apt-get update

And, finally, install:

This may take some time as
there’s a lot of dependencies for
GQRX (~1 25MB) – GNURadio being
one of them. Fear not. Once you’ve
gotten bored of tracking planes,
you can use GQRX to scan the
myriad of radio frequencies for
other cool stuff.
GQRX isn’t actually what we
want, but we do need the
dependencies that it pulls in. The
dump1 090 application is what we
really want.
Plug in your dongle, open a
terminal, and type:

sudo apt-get install gqrx

dump1090 --interactive

sudo apt-get install dump1090

It may take a minute or two to
scan and find planes, but soon

sudo add-apt-repository
ppa:gqrx/snapshots

Next, we want to add a PPA
from Roman Moravcik who has the
application we really want.
sudo add-apt-repository
ppa:roman-moravcik/gnuradio

The problem now is that neither
of these repositories have utopic
full circle magazine #93
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you’ll be presented with a terminal
screen with plane ID numbers,
squawk codes, and, if being
broadcast, the altitude, speed and
GPS co-ordinates. Neat huh?
What’s that? You’d like to see it
all on a map? Wow, you’re a tough
cookie to please. But, since
dump1 090 has a server built in,
you’re in luck, my friend!
Press CTRL + C twice to close
dump1 090, if it’s running.
In a terminal type:

dump1090 --interactive --net
--net-beast --net-ro-port
31001

And here’s the magic: open a
browser and go to:
http://localhost:8080

Well, would you look at that!
Obviously, the only planes on
the map are the ones who are
broadcasting their GPS
coordinates. It’s amazing to think
that they’re broadcasting so much
information completely open. But
they are.

I’ve only scratched the surface
of RTL-SDR devices in this article.
Try loading up GQRX and scanning
through the frequencies. It’s pretty
incredible the amount of weird
stuff you’ll find. Most of it won’t
make sense, initially, but, with a bit
of digging, you find out that some
are ordinary FM radio stations and
some are even frequencies
broadcast by garage door openers,
car alarms, etc.

The Ubuntu Podcast covers all
the latest news and issues facing
Ubuntu Linux users and Free
Software fans in general. The
show appeals to the newest user
and the oldest coder. Our
discussions cover the
development of Ubuntu but
aren’t overly technical. We are
lucky enough to have some great
guests on the show, telling us
first hand about the latest
exciting developments they are
working on, in a way that we can
all understand! We also talk
about the Ubuntu community
and what it gets up to.
The show is presented by
members of the UK’s Ubuntu
Linux community. Because it is
covered by the Ubuntu Code of
Conduct it is suitable for all.
The show is broadcast live every
fortnight on a Tuesday evening
(British time) and is available for
download the following day.

podcast.ubuntu-uk.org
full circle magazine #93
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Written by Elmer Perry

n my last article, I showed you
how to use the Mark Invalid Data
tool in Calc's Detective tools. This
time, I am going to discuss the rest
of the tools in the Detective menu
that help us trace the cells used in
formulas. Through these tools, we
can learn what cells affect the
result of a formula, what formulas
a cell affects, and what cells are
involved in a formula that results in
an error. The sheet we will use is
small to help you understand how
they work, but these tools are
most helpful in a large sheets with
complicated formulas.

SETTING U P THE SHEET
Create a new, blank sheet. In
cell A1 , enter the value 1 3. Select
cells A1 :A6. Edit > Fill > Series to
bring up the Fill Series dialog. For

Li breO ffi ce Pt.45 - Ca lc D etecti ve Tool
the Direction, select Down, and for
the Series type, select AutoFill.
Click OK, and the cells are filled
with sequential numbers. Select
cells A1 :D6. Edit > Fill > Series. This
time, select Right for the Direction,
but again select AutoFill for the
Series type. Click OK and the cells
to the right are filled with
sequential numbers.
Create totals for the rows and
columns by selecting the blank cell
at the end of the row or column.
Click the SUM button on the
formula toolbar. The cells to the
left for rows, and above for the
columns, are automatically
selected. Press the Enter / Return
key on the keyboard to accept the
results. Repeat for each of the
rows and columns.
Cell E7 will sum the totals of
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both the rows and the columns.
The formula is
=SUM(A7:D7,E1:E6)

Precedents.

TRACE D EPENDENTS

Trace Dependents (next page,
top left) draws arrows to the cells
containing formulas that rely on
The Trace Precedents function
the currently active cell. If you
(bottom right) shows the cells used select C4 then Tools > Detective >
by the formula in the current cell.
Trace Dependents, you get arrows
Traces are displayed on the sheet
pointing to C7 and E4. Both of
with blue arrows and blue frames
these cells contains formulas that
around cell ranges. This is true for reference C4 in their range. Just as
all the trace functions.
with the Trace Precedents, the
ranges of the two formulas are
Select cell E7. Tools > Detective surrounded by a blue box. To clear
> Trace Precedents. Blue arrows
the trace markers, Tools >
and frames show the cells used by Detective > Remove Dependents.
the formula. If you entered the
formula correctly, this includes all
COMMON CALC ERRORS
the totals for the rows and
columns. To clear the trace
Before we talk about Trace
markings off the sheet, select
Error, let's take a quick look at
Tools > Detective > Remove

TRACE PRECEDENTS
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some common errors you will see
in Calc.

#DIV0! – The formula is trying to

C6 – not C3. Change C3 to C6 in the
formula in E8, and the error and
the error trace arrow go away. Also
To trace the error, select cell E9. note that the precedents traces
move with the change of the
Tools > Detective > Trace Error. A
formula.
trace arrow is drawn through the
cells involved in the formula. In our
With the detective's trace tools
case, it is just two cells. You can
change the minus to a plus and the in Calc, you can trace the cells used
in a formula and determine why
arrow will clear and the error will
go away, but for now, let's leave it you didn't get the results you
the way it is. I have one more thing expected. Trace Precedents shows
you the cells used by the formula in
I want to show you. The only way
the current cell. Use Trace
to clear an error trace without
Dependents to show the cells
correcting the error is Tools >
containing formulas that use the
Detective > Remove All Traces.
currently selected cell. If you are
trying to determine why a formula
COMBINING TRACES
is generating an error in the
Tracking down a problem or an current cell, you use the Trace
error is not always as simple as just Error tool. Finally, you can combine
the different trace tools to get a
using one of the trace tools. You
broader view of what is happening,
might need to combine them to
or not happening, in your sheet.
find the real issue. Let's take our
error for example. We can select
the cell E9, and run the error trace,
and see that the formula uses the
two cells above it. However, once
you realize that both cells contain
formulas as well, you can trace the
precedents on cell E8 to see if you
can find the problem. You then
realize that the two cells used in
the formula are the same value.
Then it hits you; you meant to use
enter the formula =E7/E9. This will
generate a #DIV0 error.

function or formula.

Err:51 0 – A variable is missing from

the formula. This can happen when
you type two operators together,
divide a number by zero. As we
learned in elementary mathematics like =1 +* 3.
a long time ago, you can't divide a
number by nothing. Some
TRACE ERROR
functions, like VARP and STDEV,
will give this error when you fail to
Trace Error draws trace arrows
use the minimum required
to all the precedent cells which
arguments.
caused an error in the currently
selected cell's formula. To
#REF – The cell or range reference demonstrate this, we will need to
is invalid. This mostly happens
generate an error. #DIV0 is
when you mistype your reference
or you reference a cell or range
that no longer exists. For example
you have a reference to a sheet
that has been deleted.

#VALUE – The input was a type

other than what was expected. This probably the easiest to generate.
is often caused by referencing a
Enter the formula =C3-D2 in cell
cell with text in a mathematical
E8. The result is zero. In cell E9
full circle magazine #93
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U b u n t u Ki o s k

Written by Alessio Ciregia

f you work in a place open to the
public, for example a library or a
hospital, sometimes it could be
useful to provide a computer to
the visitors. Such a computer, even
if equipped with a mouse and a
keyboard, must be configured in a
way that people should not be able
to use all the system functions, but
only a limited set of them. For
instance, people could use the
computer to access the Internet, or
only an internal website providing
information related to your
company or your activity. And you
must configure the system in order
to prevent shell access, and inhibit
the launch of all the other
programs you don't wish to offer
to the visitors.
Such a computer is a kiosk.
(http://en.wikipedia.org/wiki/Intera
ctive_kiosk).
You can eventually configure a
PC attached to a large TV, without
keyboard and mouse, in order to
show information slides or videos.
To achieve this last goal, you can
take a look to Xibo instead, which
is a digital signage content

management system
(http://xibo.org.uk/).

#!/bin/bash

I NSTALLING

rewritehome() {
echo $home_tar
if [ -f $home_tar ]
then
rm -rf $HOME/*
tar xvf $home_tar -C /
fi
}

Let's start with installing
Ubuntu server 1 4.04 LTS. Why
Ubuntu server? Well, because, in
your kiosk, you don't need a lot of
software. Also note the use of the
–no-install-recommends parameter
used with apt-get.
Please keep in mind that after
the configuration of the kiosk
environment, it is supposed that
you will access the computer from
SSH, and not from the terminal.
So, let's install Ubuntu, enabling
automatic security updates and
installing Openssh server.
After the first reboot, log in as
the (administrator) user you have
created during the installation and
then upgrade the system:
sudo apt update
sudo apt upgrade

home_tar="/opt/kiosk/kiosk_home.tar"

xset -dpms
xset s off
openbox-session &
rewritehome
xscreensaver -nosplash &
while true; do
rewritehome
/usr/bin/firefox
done

And install these packages:
sudo apt install --noinstall-recommends xorg
openbox firefox xscreensaver
plymouth-theme-sabily cups

Install CUPS if you plan to allow
printing to your visitors.
Create a user, the kiosk user.
sudo useradd -m kiosk
sudo mkdir /opt/kiosk

full circle magazine #93
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SET UP THE ENVIRONMENT
In this configuration, you will
not launch a desktop manager, but
you will invoke X1 1 and start only
the Firefox executable.
The script shown above will be
invoked by upstart when the
system boots up. It essentially
replaces the kiosk user home
directory before starting Firefox.
And the Firefox executable is
contents ^
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placed inside a loop, in order to
relaunch it whenever it is closed.
sudo chmod +x
/opt/kiosk/kiosk.sh

Now you need to create an
upstart script:
sudo vi /etc/init/kiosk.conf
start on (filesystem and
stopped udevtrigger)
stop on runlevel [06]
console output
emits starting-x
respawn
exec sudo -u kiosk startx
/etc/X11/Xsession
/opt/kiosk/kiosk.sh

Since X needs root privileges to
start, you need to issue this
command and select “Anybody”.
sudo dpkg-reconfigure x11common

At this point we are nearly
finished. You need to reboot the
machine.
sudo reboot

And Firefox should start
automatically.

Make the desired changes now,
like adding CA certificates, security
devices, adding some kind of
extensions, etc.
Finally you need to install the
srkiosk extension
https://addons.mozilla.org/enUS/firefox/addon/srkiosk/

go to the home page, instead of
leaving the kiosk in the last visited
page by the last user. So you need
to configure the screensaver only if
you need to reset your kiosk
periodically.

Place the xscreensaver
configuration file in the kiosk user
home directory. The timeout
Please carefully read the
option is the one you need to
documents
change in order to suit your needs
(http://blogoless.blogspot.it/201 2/ (in this example the kiosk will be
07/firefox-srkiosk-add-on-fullreloaded every quarter of an hour).
screen.html), in order to
sudo vi
understand this handcrafted item
/home/kiosk/.xscreensaver
and better suit it to your needs,
timeout:
0:15:00
like changing the home page, or
lock:
False
showing the address bar.
verbose:
False
Close Firefox. At this point
Firefox will restart in a lockeddown kiosk mode.
To continue the configuration,
you have to remotely log in via SSH.

LAST STEPS.
The use of the screensaver can
be useful – not only to have a nice
effect on the screen after an
amount of time. It is useful to
“reset” the session after a period of
inactivity. For instance, it is nice to
full circle magazine #93

splash:
False
captureStderr: True
dpmsEnabled:
False
dpmsQuickOff:
False
mode:
one
selected:
0
programs: resetkiosk.sh -root
\n\

#!/bin/bash
PID=`ps -u $UID -f |grep
firefox |grep -v grep | awk
'{ print $3 }'`
kill $PID

SNAPSHOT TIME
Finally, you need to take a
snapshot of the kiosk user home
directory. Such snapshot will
overwrite the home directory every
time the machine reboots, or when
the kiosk session is reset, or when
Firefox is closed.
So, remember that every time
you make changes to the kiosk user
home directory, you will need to
make a tar of that directory, and
place it in the appropriate place:
take a look at the kiosk.sh script
(previous page, top right).
rm -rf /home/kiosk/.cache/

Next, you need the script that
xscreensaver will invoke after the
period of inactivity (Listing 4). As
said, xscreensaver, instead of
launching a real screen saver, will
actually run this script.

tar cpvf
/opt/kiosk/kiosk_home.tar
/home/kiosk/

sudo vi
/usr/lib/xscreensaver/resetki
osk.sh

Another useful task to
accomplish is related to some
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DISABLING TTYS
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hardening of the system. For
instance, you can prevent naughty
users from booting the system into
single-user mode, or from
switching between virtual consoles
(the terminals you can use by
pressing functions keys like
CTRL+ALT+F1 ).
Let's start with GRUB. First of
all, it needs to be as quiet (less
verbose) as possible, just for
aesthetic purposes (Listing 5).
sudo vi /etc/default/grub

...
GRUB_TIMEOUT=0
GRUB_CMDLINE_LINUX_DEFAULT="q
uiet splash vga=current
loglevel=0"
...

Then, you can set a password in
order to disallow users to boot
Linux into single-user mode. Use
the command grub-mkpasswdpbkdf2 to create an encrypted
password, then edit some files.
Put the following lines at the
end of /etc/grub.d/00_header
cat << EOF
set superusers="root"
password_pbkdf2 root

<the_sting_obtained_from_the_
grub-mkpasswd-pbkdf2_command>
EOF

At this point, a user and a
password will be requested for
each GRUB menu entry, even for
booting Linux in the normal way;
that is what we don't want. So add
the –unrestricted parameter
(shown below in black) in each
menuentry line of the
configuration files. For instance in
/etc/grub.d/1 0_linux
...
echo "menuentry '$(echo
"$title" | grub_quote)'
--unrestricted ${CLASS}
\$menuentry_id_option
'gnulinux-$version-$type$boot_device_id' {" | sed "s
/^/$submenu_indentation/"
else
echo "menuentry '$(echo
"$os" | grub_quote)'
--unrestricted ${CLASS}
\$menuentry_id_option
'gnulinux-simple$boot_device_id' {" | sed
"s/^/$submenu
_indentation/"
...

In this way, a user and a
password will be asked only if the
user tries to edit the GRUB menu
entries, using the 'e' key.
Now you must issue the sudo
full circle magazine #93

update-grub command to make the
Maybe a kiosk solution could be
changes effective.
better achieved, but as far as I
know, I have not found any better
At the end, you can disable
alternatives. This solution works
virtual terminal consoles by
for my needs: maybe it could be
deleting the tty files under the
useful to you or it could be a
/etc/init directory:
starting point for a better
implementation.
sudo rm /etc/init/tty*

Further works and conclusion
In order to harden the machine,
you should set up a password in the
BIOS, and prevent boot from
CD/DVD or USB ports. And about
USB, you should prevent the use of
such ports at least by making the
PC inaccessible from the users.
Other things to do? Configure a
custom theme for the boot screen.
Look at ways to disable possible
keyboard shortcuts.
Instead of running Firefox, you
might wish to run a video player or
a pictures slide-show: you can give
it a try by putting some other
command in the while loop.
This paper is based on a post
found on
https://thepcspy.com/read/buildin
g-a-kiosk-computer-ubuntu-1 404chrome/
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Written by Mark Crutch

o conclude our foray into the
world of clones, I'm going to
spend a few articles describing
Inkscape's “Create Tiled Clones...”
dialog (which I'll refer to as just the
Tiled Clones dialog from here on).
This is arguably one of the most
powerful, and most confusing,
dialogs in the whole application, so
take a few moments to prepare
yourself before we dive in.
You've already seen the easy
way to create a clone: select the
parent object and press ALT-D (or
use Edit > Clone > Create Clone). If
you want a second clone from the
same parent, you can either repeat
that process, or duplicate the first
clone (using CTRL-D this time). Do
you want a handful of clones? Drag
the first one round the screen,
stamping copies by hitting the
spacebar from time to time. But
what if you want a hundred clones?
Or a thousand? And what if you
want them precisely positioned? Or
you want each clone to be rotated
or scaled a little? The Tiled Clones
dialog can do all this, plus a lot
more.

We'll start by creating an object
to use as the parent for our clones.
To keep things simple for the time
being, I'll use just a coloured
square with rounded corners, but
the parent can be almost any
individual object or a group. 3D
boxes, however, don't work with
the Tiled Clones dialog – though
you can convert them into a group
of simple paths first to get the
same effect, if you don't mind
losing the ability to edit the parent
as a 3D box. With a parent object
created and selected, open the
Tiled Clones dialog via the Edit >
Clone > Create Tiled Clones... menu
entry.
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Initially the dialog doesn't look
too complex, but if you step
through the tabs, you'll quickly see
that there are a lot of fields and
controls hidden away. The first tab,
Symmetry, has only a single pop-up
menu, but even that contains 1 7
different options. For now, we'll
just stick with the first one: “P1 :
simple translation”. This will let us
create simple rectangular arrays of
clones, and is the easiest to
understand when first getting to
grips with this dialog.
Beneath the tab panels are
some global options to define the
number of clones you want to
create, or the area you want them
to cover. Note that I said “cover”
rather than “fill”. Think about tiling
a bathroom wall: you need enough
tiles to cover the wall, even if it
means some overhang, and the
need to cut some to size around
the edges. Similarly, Inkscape will
create enough tiles to cover the
specified area (defined in terms of
width and height), leaving you to
optionally clip them yourself if they
overhang. The “Use saved size and
position of the tile” option should
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be left unchecked for now – we'll
take a look at that in a later article.
To create some tiles, first press
the Reset button. This will put the
values in all of the tabs back to
sensible defaults, so is usually a
good starting point. Now enter
some values into the “Rows,
columns” fields. I'm going to start
with a 3x4 array of clones. Finally,
with your parent object selected,
click the Create button.

There are a few things to
observe about the array of clones
that has been created. First, notice
that your parent object remains
selected once the clones are
created. This makes it easy to click
the Remove button in the dialog to
contents ^
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delete all of the clones at once if
you're not happy with the result.
Be aware that the first clone is
placed directly on top of the
parent object. If you change the
focus and then need to re-select
the parent, clicking in the top left
corner will actually select the
clone. The easy answer is just to
select any of the clones, then press
SHIFT-D or use Edit > Clone >
Select Original.
Take a look at the positions of
the clones. After resetting the
parameters in the dialog, the
default behaviour is to create the
clones in such a way that they all
butt up against one another. When
selecting objects in Inkscape, the
dashed line that acts as a selection
cue is referred to as the “Bounding
Box”. The dimensions of this box
form the basis for positioning the
clones. The first column is moved
to the right by 1 00% of the
bounding box width. The second
column is moved by 200%, and so
on. The rows follow identical rules
based on the bounding box height
instead. This may sound like a
slightly abstract way to describe
the positioning of the clones, but
the Shift and Scale tabs in the
dialog use “percentage of
bounding box width/height” as

their units of measurement, so it's
easiest to think in those terms.
To further confuse matters,
Inkscape has two different types of
bounding box: the visual bounding
box, which includes any stroke that
is applied to your object; and the
geometric bounding box, which is
based purely on the core object –
regardless of its stroke. You can
choose which one Inkscape uses for
selections in the Tools pane of the
File > Inkscape Preferences…
switching the preferences between
dialog. The difference between
them is clear when an object with a visual and geometric bounding
boxes does have an effect on the
very thick stroke is selected.
tiling. Even more confusingly, the
behaviour seems to be the
opposite of what you might expect.
Look at the same thick-stroked
rectangle above when it's tiled
using each of the two preferences.

According to the
documentation, Inkscape always
uses the geometric bounding box
when creating tiled clones. This
doesn't tally with my own
experience of Inkscape 0.48 on
Linux Mint 1 7. I've found that
full circle magazine #93

quick way to make a large number
of clones. But the real power
comes from the myriad ways in
which those clones can be
positioned and transformed. Let's
start by loosening up the array of
clones a little by using the Shift
tab.

From now on, I'll mostly stick to
using shapes with no stroke to
demonstrate tiled clones, so this
discrepancy won't be an issue. But
do bear it in mind if you're trying to
tile objects with strokes and the
clones aren't appearing in the
positions you expect.
The default arrangement of a
tightly packed array may be fine if
you just want to use this dialog as a

22

contents ^

HOWTO - INKSCAPE
The key to understanding this
tab is that the controls are
arranged in three columns. The
controls in the first column affect
how much each row of clones will
be shifted around. The controls in
the second column affect how
much each column of clones will be
shifted around. The third column
applies to every clone, and is used
to add a random amount of shift in
the x and y directions.
A simple example to begin with:
maintaining the rectangular array
whilst adding a little space
between the clones. The first thing
we want to do is add some space
between each column, so we'll put
a positive value in the top-middle
control. This field alters the xposition (it's in the Shift X row of
controls) for each column of clones
(it's in the middle column of
controls). A value of 1 0 in here will
add 1 0% of the bounding box
width before it's added to the
position of each column, so rather
than being placed at 1 00%, 200%,
300%... they'll now be placed at
1 1 0%, 220%, 330%... – each
subsequent position is increased by
1 1 0%, rather than the standard
1 00%.

I've also put a value of 50 into
the first control on the second line.
This will add 50% of the bounding
box height to the y-position (as it's
in the Shift Y row of controls) to
every row of clones (it's in the first
column of controls). The rows will
therefore be placed at 1 50%,
300%, 450%... The result is that
we've loosened up the array, with
more vertical space than
horizontal.

If you don't want your clones
quite so rigorously positioned,
simply put a positive number into
one (or both) of the Randomise
fields in the third column. The
value you place in here will be used
as an upper limit, so entering 20
into the Shift X control will allow
the horizontal position of each
clone to shift by up to 20% of the
bounding box width. This is applied
in addition to any other offsets, so
full circle magazine #93

you can still loosen up the whole
array as before, then add a little
randomness on top. Alternatively
you could use the Tweak tool (see
part 22), or click on the Unclump
button at the bottom of the Tiled
Clones dialog, which jostles the X
and Y coordinates of each clone a
little. The latter can sometimes be
useful if you're trying to create a
more “natural” look, by cloning a
drawing of a leaf or snowflake.

You can make this look even
more wall-like by checking the
Alternate control for the Per Row
column. This causes the offsets in
that column of controls to be
applied first as a positive value, and
then as a negative. So the rows
first shift to the right by 50%, then
back to the left by the same
amount, then to the right again,
and so on.

As well as a simple rectangular
array, the shift tab can produce
more interesting results. Do you
need to draw a simple brick wall?
Start with one brick, but put a 50%
offset into the very first field. This
will add 50% of the bounding box
width to the x-position for each
row of clones. This has the effect
of causing each row to move to the
right by half of the parent's width.
Our wall is looking good, but
wouldn't a little mortar help? You
might be tempted to space the
tiles out by putting 1 0% into some
of the other fields. Whilst this will
successfully spread them
horizontally, any efforts to spread
them vertically will fail because
that Alternate setting will also
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alter the spacing you enter in the
first column of the Shift Y row.
Rather than adding a constant 1 0%
spacing between rows, you'll
actually be adding 1 0% then
removing 1 0%, then adding it
again, and so on.

There are a few ways to solve
this problem, all of which rely on
simply adding to the size of the
parent's bounding box so that
there's no need to add extra
padding when creating the clones.
You could add a thick stroke and
ensure that the geometric
bounding box is in use. Create the
clones with just the 50% value in
the first box and the Alternate
control checked and you should get
some additional spacing based on
the thickness of the stroke. Then
just remove the stroke from the
parent object, and all the clones
will immediately be changed as
well.
A variation on this theme is to
add some blur to your parent
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object. This affects the size of the
visual bounding box, so, provided
you have Inkscape's preferences
set to use the geometric bounding
box (remember, they work the
wrong way round in this dialog),
your clones will get some extra
space around them. Then remove
the blur from the parent.
The final approach is to put your
parent object in a group with
another, larger object. The second
object is there purely to set the
size of the group's bounding box.
Create your clones, then enter the
parent group and remove the
temporary object. This approach
results in clones of a group, rather
than the object itself, but avoids
the need to mess with Inkscape's
preferences.

A similar effect can be achieved
by setting the Exponent value to
something greater than 1 . The
opposite effect – reducing the
difference between each offset –
can be achieved by setting the
Exponent value to less than 1 .

The last pair of controls in this
tab, the Exclude Tile checkboxes,
The Cumulate checkboxes
can be used to remove the
determine how any offsets are
added to the base position for each bounding box dimensions from the
clones' calculated positions.
clone. Usually, the offset is added
Settings that would previously
to the bounding box width or
have resulted in positions of 1 1 0%,
height once, and that single value
is used as the basis of every row or 220%, 330%... become 1 0%, 20%,
column of clones. Checking this box 30%... when this checkbox is
enabled. This allows you to create
means that the offset is added
clones with only a small offset
again for each row or column,
from the parent – usually resulting
resulting in values that get
in them overlapping it to some
progressively larger.
extent when creating a simple
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rectangular array.

One final thing to note is that
it's possible to enter a negative
shift for the x and x positions. This
results in a shift to the left (for x)
or upwards (for y), and converts
the standard 1 00%, 200%, 300%...
positions to 90%, 1 80%, 270%... if
the offset is set at 1 0%. This is
another way to create an
overlapping arrangement of
clones, but, depending on the
shape of the parent object, it may
be just what you need to make
everything fit together neatly.

Try playing with a few
combinations of values and
settings in the Shift tab. You'll
quickly find that it's easy to create
wild and unexpected clone
placements – thank goodness for
that Reset button! Try to
understand how each individual
control contributed to the clones'
placement, and how the threecolumn layout relates to the rows
and columns of clones, because,
next time, we'll be building on this
knowledge to explore some of the
other tabs in the Tiled Clones
dialog.

Mark uses Inkscape to create three
webcomics, 'The Greys', 'Monsters,
Inked' and 'Elvie', which can all be
found at
http://www.peppertop.com/
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H O W-TO

Ard u i n o

Written by Ronnie Tucker

ast month, I showed you what I 80,0);
had of my automated chicken
myServo.write(reverse);
coop door. Well, as ever, I managed
to fix one problem – and then
It’s not elegant by any means,
introduce twice as much
but it works.
complexity. My system has now
gone from a simple servo and LDR
You know the LCD screen from
to a full servo, LDR, humidity
the laser trip-wire project.
sensor and LCD screen.
Implementing that was pretty
much a copy/paste job, but with
A servo normally goes from zero the added complexity of the
degrees to 1 80 degrees and, in the humidity sensor.
code, we can specify which angle
we want the servo to move to. A
The humidity sensor is a DHT1 1
full servo is (as far as I can gather)
model; simply use an include for
somewhere between a motor and a the dht1 1 library. If you don’t have
servo. You treat it like a servo in
it, the relevant files and info are at:
the code, but it’s more like a motor http://playground.arduino.cc/main/
in that it will turn 360 degrees, but DHT1 1 Lib. Implementing the
you can not specify an angle. This
humidity and temperature
posed quite a problem when I had functions were a bit tricky as it uses
to run the servo forward to raise
some pretty complex maths to
the door, then in reverse to lower
convert the usual numbers into
the door. I eventually solved that
something we can read as ⁰C. I’m
problem by a bit of a botch using
not even going to pretend I know
the open command:
what these functions are doing. I
copied and pasted them from other
myServo.write(openDoor);
code I found on the DHT1 1 page,
and on some Google searches. The
and using a map command to
loop() has a chk where we give it
throw reversed numbers at it:
the pin that the sensor is on:
reverse=map(openDoor,0,1023,1
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int chk =
DHT11.read(DHT11PIN);

Later, we run a switch command
to check for the sensor being
online (again, not my code). There
are several lines for printing the
converted values to the screen:
Serial.print("Humidity (%):
");
Serial.println((float)DHT11.h
umidity, 2);
Serial.print("Temperature
(°C): ");

the humidity values inserted.
lcd.setCursor(0, 1);
lcd.print("Temp. ('C): ");
lcd.print(DHT11.temperature);

Now that I have the prototype
made, I just need to put the
Arduino Nano (with breadboard) in
a plastic tub, and run longer wires
out to place the LCD and sensor
somewhere convenient.
My final code for this is at:
http://pastebin.com/ES421 PHV.

Serial.println((float)DHT11.t
emperature, 2);

I kept this in as it’s a good check
to see if the sensor is working prior
to adding the LCD. At the end, it’s
the same LCD print commands
from the laser trip wire, but with
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Ronnie is the founder and (still!)

editor of Full Circle. He's a part-time
arts and crafts sort of guy, and now
an Arduino tinkerer.
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W ri t e F o r F u l l C i rc l e M a g a z i n e

Written by Ronnie Tucker

G UIDELINES

T

he single rule for an article is
that it must somehow be

document.

REVIEWS

• Images should be JPG, no wider
than 800 pixels, and use low
compression.

G AMES/APPLICATIONS

linked to Ubuntu or one of the
many derivatives of Ubuntu
(Kubuntu, Xubuntu, Lubuntu, etc). • Do not use tables or any type of
bold or italic formatting.

RULES

• There is no word limit for articles,
but be advised that long articles
may be split across several issues.
• For advice, please refer to the

Official Full Circle Style Guide :

http://url.fullcirclemagazine.org/75
d471
• Write your article in whichever
software you choose, I would
recommend LibreOffice, but most
importantly - PLEASE SPELL AND

GRAMMAR CHECK IT!

• In your article, please indicate
where you would like a particular
image to be placed by indicating
the image name in a new
paragraph or by embedding the
image in the ODT (Open Office)

If you are writing a review,
please follow these guidelines :
When you are ready to submit
your article please email it to:
articles@fullcirclemagazine.org

TRANSLATIONS
If you would like to translate
Full Circle into your native
language please send an email to
ronnie@fullcirclemagazine.org and
we will either put you in touch with
an existing team, or give you access
to the raw text to translate from.
With a completed PDF, you will be
able to upload your file to the main
Full Circle site.
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When reviewing games/applications please state clearly:
•
•
•
•
•
•
•

title of the game
who makes the game
is it free, or a paid download?
where to get it from (give download/homepage URL)
is it Linux native, or did you use Wine?
your marks out of five
a summary with positive and negative points

H ARDWARE

When reviewing hardware please state clearly:
•
•
•
•
•
•
•

make and model of the hardware
what category would you put this hardware into?
any glitches that you may have had while using the hardware?
easy to get the hardware working in Linux?
did you have to use Windows drivers?
marks out of five
a summary with positive and negative points

You don't need to be an expert to write an
article - write about the games, applications
and hardware that you use every day.
27

contents ^

https://spideroak.com
full circle magazine #93

28

Get 25% off any SpiderOak package
with the code: FullcirclemagFans
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L I N U X L AB

C o m p i l i n g A Ke rn e l - P a rt 6

Written by Alan Ward

n the last installment of our
series, we introduced some small
changes into the Linux kernel,
altering the code that produces
information on our processors in
the /proc virtual file-system. In this
last episode, we will try to produce
some entirely new code, insert it
into the kernel source, compile and
execute the lot.

other way around, to input
information or commands into the
kernel. To illustrate this, I will be
writing a simple module that
creates a new entry
/proc/hostname. When printed,
this virtual file will give us our
current system hostname. But
since the /proc system is bidirectional, this same file can also
be written to. When this is done,
the text should be received by the
kernel and the hostname re-set
accordingly.

source code tree, or could even be
placed in a completely separate
directory if we so wished. Since we
will be working within the /proc
framework, I wrote a new file
within the fs/proc directory that I
called hostname.c

executed on the /proc file.

The concept of the callback
function is rather common to
operating system construction.
When we are part of the system
that is waiting for something to
happen - for example, for a
event - we have a choice
CONSTRUCTING A NEW keyboard
of strategies we can follow. The
MODULE
first would be to poll the keyboard
periodically, checking if a key has
To do so, instead of adding
The
basic
points
required
to
been pressed and new keystrokes
features to the kernel proper, it
build
a
kernel
module
are
as
follow:
are available to be processed. But
seems easier to simply create a
this is not very efficient, since a lot
new module. This is more
•
We
need
to
provide
code
that
will
This
is
actually
not
a
very
of processing can be going on even
convenient in not having to worry
initialize
any
data
structures
and
original application of the /proc
if nobody is actually at the
about breaking the complete
/proc
entries
we
create
whenever
file-system, since there already
keyboard.
kernel and making your system
the
module
is
loaded.
exists an entry that does just that:
unresponsive - remember to do
The second way of responding
this on a non-production computer! /proc/sys/kernel/hostname.
•
We
also
need
to
provide
more
However, it will serve as an
to events is by using the interrupt
- and the new module can simply
code
to
clean
up
properly
when
the
mechanism. In essence, this
be inserted into and removed from example of module construction,
module
is
unloaded
from
memory.
and we will also be granting write
delegates the waiting to the
memory any number of times
This
is
a
bit
different
from
other
permission
to
any
user,
and
not
hardware itself. What happens is
during testing. Compiling a single
operating
systems,
in
that
Linux
serving hostname changing to root
that the driver, on initialization,
module also takes much less time
kernel
modules
can
very
well
be
as is standard behavior for the
will prepare a certain function to
than a complete kernel.
removed
during
system
execution
existing entry (perhaps for a good
process keystrokes. The function is
if
no
longer
needed.
reason).
not yet executed, but remains
In this episode, we will also stay
dormant within memory. Its
within the /proc file-system, and
•
Finally,
we
should
write
any
The source file or files for the
address (a pointer) is passed to the
see how it can be used to
callback
functions
that
are
to
be
new module can be placed
interrupt management system.
communicate not only from the
invoked
when
operations
are
wherever
we
wish
inside
the
kernel
When a keyboard interruption is
kernel to the user, but also the
full circle magazine #93
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detected - when somebody
pressed a key - this function is
invoked.

static int __init hostname_proc_init(void)
{
printk(KERN_INFO "hostname loading\n");
hostname_entry = proc_create("hostname", 0666, NULL, &hostname_proc_fops);

This callback function can also
if (hostname_entry == NULL)
be used whenever we are waiting
printk(KERN_INFO "hostname could not create /proc entry\n");
else {
for other types of events that
hostname_entry->proc_iops = &hostname_proc_iops;
come from outside the kernel.
printk(KERN_INFO "hostname /proc entry created\n");
}
They may be physical events such
as a mouse-click or a packet
return 0;
arriving at a network interface, or
}
logical (software) events such as, in
our case, a user reads or writes a
removed. Please note we are
adhered to. I will be creating the
contain references to further
file.
sticking to a naming convention
new /proc entry, with access mode callback functions, that will be
often used within the kernel
0666 to give read and write access used to check user access
INITIALIZING AND
source code: all our functions will
to all users (owner, group and
permissions
start with our module name
other users). I will also be
“hostname_proc_permission”, to
REMOVING THE
“hostname”, followed by “proc” to outputting quite a lot of
provide text when our /proc entry
MODULE
indicate this code is working inside information to the kernel log, so
is read in “hostname_proc_open”,
the /proc file-system, and finally
the “dmesg” command can be used and to read and parse user data
The first thing we will do is
we give each function a distinctive when debugging.
when the /proc entry is written to
insert the last two lines of the
name that indicates use.
in “hostname_proc_write” (below).
modules. These are:
Note the presence of addresses
We will follow the same
to two tables:
Other operations are left with
module_init(hostname_proc_ini
convention when creating a handle “hostname_proc_fops” and
their default handler functions,
t);
to reference this module itself,
“hostname_proc_iops”. These
“seq_read”, etc.
module_exit(hostname_proc_exi
that can come in handy to check
t);
static const struct inode_operations hostname_proc_iops = {
that we were correctly installed:
.permission = hostname_proc_permission,
};
“module_init” indicates the
static struct proc_dir_entry
function to be invoked when the
*hostname_entry = NULL;
static const struct file_operations hostname_proc_fops = {
module is loaded into memory, in
.open
= hostname_proc_open,
.read
= seq_read,
this case “hostname_proc_init”,
Now, we need to write the code
.write
= hostname_proc_write,
while “module_exit” does the same (shown above) for module
.llseek
= seq_lseek,
for the function to be invoked to
.release
= single_release,
initialization. The function
};
clean up when the module is
interface is standard and must be
full circle magazine #93
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When the module is removed
from memory (shown top right), in
our case very little housekeeping is
needed, just removing the /proc
entry with the “proc_remove”
function. As before, I tend to
provide much logging information
for ease of debugging. Most of this
should be removed if this module
were to enter production status.

RESPONDING TO
READING AND
WRITING THE /PROC
ENTRY
As in the previous part of this
series, responding to a user
reading the /proc entry is split up
into two functions. Function
“hostname_proc_open” is the
actual callback routine provided in
“hostname_proc_fops”. But this
has access to only the /proc entry
file and inode pointers. For ease of
access, it is nice to use the
“single_open” function to provide a
sequential file access pointer “m”
that can then be used with the
“printf” to write formatted output
to the file. Code is shown bottom
right.
Note the use of the “utsname”

static void __exit hostname_proc_exit(void)
{
printk(KERN_INFO "hostname unloading\n");

}

if (hostname_entry == NULL)
printk(KERN_INFO "hostname /proc entry does not exist, not removing\n");
else {
proc_remove(hostname_entry);
printk(KERN_INFO "hostname /proc entry removed\n");
}

static int hostname_proc_open(struct inode *inode, struct file *file)
{
return single_open(file, hostname_proc_show, NULL);
}
static int hostname_proc_show(struct seq_file *m, void *v)
{
seq_printf(m, "system hostname is currently: %s\n", utsname()->nodename);
seq_printf(m, "write new name to this file to change hostname\n\n");
return 0;
}

mechanism to retrieve our system's system hostname is currently:
current hostname. As set out in the alan-vaio
uname manual page, there is
write new name to this file
to change hostname
actually no requirement for
hostname and nodename to be the
Responding to writing to our
same for POSIX compliance.
However, this does seem to be the entry is a bit more complex. Data
written by the user process will be
case for Linux.
accessible by the “user_data”
pointer, and the number of
With this in place, the user will
characters available to use will be
be able to read from our /proc
in “len”. But this data is within a
entry:
user-space data structure, that
cat /proc/hostname
must be copied into an equivalent
kernel-space table before working
full circle magazine #93
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on it.
We should also be very careful
to check user input for consistency.
Any actions we take from within
kernel code based on incorrect
user entry can affect the working
of the complete system, so better
be extra cautious here.
In our case, it will be a simple
case of copying over the first
characters supplied by the user,
until a non-printable character (i.e.
anything with code less than a
contents ^
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space) comes up. If this number of
characters is less than admissible
hostname length (check! check!
check it over again!), copy the new
hostname over to the
corresponding utsname table.
Finally, we should return the
number of characters we have
effectively read from user input
before closing this function. This is
taken into account by the system;
if less than the available number of
characters have actually been
treated, the system will invoke this
function once more - or as many
times as necessary - to handle all
input. So we will simply return the
same number of characters “len”
(given as input length) to indicate
we have handled them all and no
longer need to be invoked. Code is
shown right.
Once this is in place, any user
will be able to write text to our
entry to provoke a change of
hostname:
echo "our-new-hostname" >
/proc/hostname
hostname
our-new-hostname

static ssize_t hostname_proc_write(struct file *file, const char __user *user_data, size_t
len, loff_t *offset)
{
int buffer_size = 0;
int i;
char buffer[MAX_BUFFER_SIZE];
printk(KERN_INFO "hostname_proc_write, len=%ld\n", len);
buffer_size = len > MAX_BUFFER_SIZE ? MAX_BUFFER_SIZE : len;
i = 0;
buffer[0] = '\0';
while ((i < buffer_size) && (user_data[i] > ' ')) {
buffer[i] = user_data[i];
i++;
}
buffer[i] = '\0';
buffer_size = i+1;
printk(KERN_INFO "wrote %d bytes\n", buffer_size);
printk(KERN_INFO "hostname=%s\n", buffer);
if (buffer_size <= __NEW_UTS_LEN)
for (i = 0; i < buffer_size; i++)
utsname()->nodename[i] = buffer[i];
}

return len;

THE FINAL MODULE
SOURCE CODE
Our module will not compile
yet, since I left out all the include
sentences that will be needed to
indicate function prototypes.
These need to be inserted at the
top of our file. It may also be a nice
idea to pass the compiler some
data on what this module is, its
author, and the license under
which it is distributed:
full circle magazine #93

MODULE_AUTHOR("Alan Ward");
MODULE_LICENSE("GPL v2");
MODULE_DESCRIPTION("hostname
module for Full Circle
Magazine");

for Full Circle Magazine
license: GPL v2
author: Alan Ward
srcversion:
431F7E34A05708273893D24
depends:
vermagic: 3.13.0-24-generic
SMP mod_unload modversions

This information will be inserted
within the module itself, and may
Once we have all the bits and
be consulted with the
pieces,
the final module code can
“module_info” utility command:
be assembled as follows:
$ modinfo hostname.ko
http://pastebin.com/5d6KxCRZ
filename:
/home/alan/Escriptori/linux/f
s/proc/hostname.ko
description: hostname module
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COMPILING AND
INSTALLING THE NEW
MODULE
When our new module is
compiled, it will need to be linked
against existing kernel data
structures and functions. The
easiest way to do this is to
integrate the new module within
the existing source code directory
make structure. Edit the Makefile
in the same directory, and add:

running kernel with:
sudo insmod hostname.ko

and use it as indicated. The
module may be unloaded if desired
with:
sudo rmmod hostname

Reading the system kernel logs
is advisable to check everything is
working correctly:
dmesg | tail

obj-m := hostname.o

We can now proceed to compile
all modules, including our new one,
by going up to the kernel source
code root directory and executing
make with the commands:
cd ../..
make modules

Alternatively, it may be practical
to compile just the modules in this
directory from within the same
directory with the command:
make -C /lib/modules/`uname
-r`/build M=$PWD modules

When this is finished, we can
install the module within the

[ 7501.047170] hostname
loading
[ 7501.047178] hostname /proc
entry created
[ 8095.253713]
hostname_proc_write, len=17
[ 8095.253722] wrote 17 bytes
[ 8095.253726] hostname=ournew-hostname
[ 8381.501772] hostname
unloading
[ 8381.501784] hostname /proc
entry removed

We are now at the end of our
six-part series on compiling the
Linux kernel. Altering, compiling
and installing a kernel is perhaps
one of the more demanding
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activities we can do on our favorite
operating system, but it is
perfectly achievable with a little
patience and going about it in a
systematic way. OK, so a little
stubbornness may also help when
things do not go as expected the
first few times.

Kudos to everybody who has
participated in developing the
Linux kernel for giving it to the
world; it is not said often enough.

In any case, the main point that I
would like to make is that this can
be done – not by computer wizards
and professional hackers, but by
“normal” people... simply should
they choose to go down this path.
Doing so will certainly enrich your
experience, as you may end up
learning things about your
computer you may never have
suspected. I certainly did when
preparing this series.
This, in turn, means that an
open-source kernel running an
open-source operating system has
some real possibilities of getting
checked by many eyes, and having
improvements proposed and
implemented when needed.
Although the reader may choose
not to investigate the kernel in
person, we all benefit from the
very existence of the possibility
with a more stable and up-to-date
computing platform.
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Alan teaches computer science at

Escola Andorrana de Batxillerat
(high-school). He has previously
given GNU/Linux courses at the
University of Andorra and GNU/Linux
systems administration at the Open
University of Catalunya (UOC).
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T ryi n g F re e B S D - P a rt 1

Written by Charles McColm

hat do Yahoo, Yandex.ru
(bigger than Google search
engine in Russia), the Playstation 4,
pfSense, Hotmail, and Netcraft
have in common? They’ve all run
FreeBSD, or a fork of FreeBSD at
some time. While Hotmail
(outlook.com) has been on
Windows server for a number of
years, those of you who remember
the old Hotmail will probably also
remember how fast hotmail was
when the site ran FreeBSD.
Many years ago, I ran FreeBSD
too, that was until I ran into an
issue getting a printer driver for
the HP Deskjet I’d just bought.
Prior to this, I was one of the folks
who had a FreeBSD subscription
from Walnut Creek. After a broken
release (in one release
/stand/sysinstall was broken and
the way to fix it was getting a file
from the Internet, defeating the
purpose of buying the CDs), and
high speed becoming more
available in our area, I stopped
subscribing. The CD subs were a
great value, but all things change
and I began shifting back towards
Linux (I used Slackware 96 back in

1 997).

platforms. FreeBSD 1 0.1 -RELEASE
(the current release at the time of
One of the things that attracted this writing) ISOs are available for
me to FreeBSD was the interesting amd64, i386, ia64, powerpc,
collection of software in the ports powerpc64, sparc64 and armv6
system. Ports are essentially
architectures. My recollection of
Makefiles that link to downloads
FreeBSD was that it was blazingly
(or on the CD/DVD) of source code. fast. What I forgot was, like
You make the software much the
Gentoo, Arch, or Slackware,
same way you do with a Linux
FreeBSD takes a bit of reading and
distribution like Arch, Gentoo, or
tweaking to get going…
Slackware. Another great thing
about FreeBSD is that it is available
Installing FreeBSD isn’t
for a wide range of hardware
particularly difficult. In fact it

follows a similar process as a Linux
install: Select a keyboard mapping,
choose a hostname, choose some
optional components (extra docs,
games, the ports tree and system
source code), partition the hard
drive, wait for the base packages
to install, set the root password,
configure a network connection,
set the timezone, choose some
services to start (sshd, ntpd,
powerd, etc), add more users, and
make any final changes before
rebooting to an installed system.
Anyone with experience installing
Linux will find the process of
installing FreeBSD familiar. The
FreeBSD project provides decent
online documentation, the
FreeBSD Handbook at
https://www.freebsd.org/doc/hand
book/ to guide anyone through an
installation.
All told, my FreeBSD installation
took just over 1 5 minutes on a
Pentium 4 1 .7GHz notebook with
2GB RAM and a 5400rpm (slow)
80GB hard drive. One issue I ran
into with my installation was that
the Intel wireless card driver didn’t
seem to get installed pre-
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installation so I had to use an
ethernet connection. I installed
FreeBSD 1 0.1 . By default it uses
the GPT partition scheme allowing
for 3TB+ hard drives. There’s also
an option to use the Zettabyte File
System (ZFS). And, unlike some, I
prefer to see each service load up
rather than a spinning or flashy
logo.

Whatever the case, it appeared to
me that FreeBSD was taking way
too long just to query the ftp
server (I could ping the server). At
one point, I got an error message
“error no pkg database found.” I
tried installing the packages, using
the DVD as a source, and ran into
the same ‘no pkg database’ error. I
found a couple of forum posts
related to the error:
Once the install was finished, I
https://forums.freebsd.org/thread
found myself staring at every new s/bsdconfig-no-pkg-8-databaseLinux user’s nightmare: a command found.4921 6/
line prompt. For those looking for a https://forums.freebsd.org/thread
desktop out-of-the box experience, s/error-no-pkg-8-databasePC-BSD is a good choice:
found.481 42/
http://www.pcbsd.org/.
Unfortunately neither posts
It’s worth mentioning here that helped fix the issue. So I tried some
the FreeBSD handbook covers
of the pkg commands:
sysinstall. If you’re using FreeBSD
pkg update
1 0.1 , it uses bsdinstall instead of
sysinstall. Browsing through the
pkg upgrade
/sbin folder, I found a package
named bsdconfig which seems to
do the same job of installing
packages (other than ports) that
sysinstall did. But, when I tried
bsdconfig, it seemed to hang for a
very long period while it was
querying any of the FreeBSD ftp
servers. I’m not sure if this was a
matter of me being too impatient
waiting for the list to download, or
whether there was an issue.
full circle magazine #93

Both commands worked and
updated the packages available to
the system from the Internet. So
next I tried:
pkg install xfce

A bunch of packages and
dependencies were installed. Still
at a terminal I tried:
pkg install xorg

Many more packages installed.
This time I tried the startx
command and voila a desktop (not
XFCE but TWM… but still a
desktop). Unfortunately, when I
tried to exit the TWM desktop
using the Exit command in the
menu, FreeBSD hung – the TWM
window decorations disappeared
but the windows stayed. I tried
switching virtual terminals to issue
a kill command, no luck.

The pkg command seems to
work in a similar way to apt. pkg
search <packagename> searches
for <packagename> much the way
apt-cache search can be used to
find packages on a Debian/Ubuntubased system.
At this state in the game, I have
FreeBSD running and can find and
install new packages. Next month,
I’ll report more on my experiences
with the ports tree. Getting back
into FreeBSD after a more than 1 0year absence makes me appreciate
how easy Ubuntu makes things for
desktop users. And while it’s a bit
like comparing apples and oranges,
FreeBSD can be made to look and
run the same desktop software
that Linux can. I’m sure, with a bit
more reading and work, it will all
come back. Next month, Part 2 of
Trying FreeBSD.

Charles is the author of Instant

XBMC, and project manager of a notfor-profit computer reuse project.
When not building PCs, removing
malware, and encouraging people to
use GNU/Linux, Charles works on
reinventing his blog at
http://www.charlesmccolm.com.
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D ID YOU MISS ANY?
New to Packt? Check out some of our all time classics to build your essential
learning library and make sure you start 2015 ahead of the curve.
https://www.packtpub.com/books/packt-classics
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U b u n tu M a te 1 4.1 0

Written by Michael Davies

I

recently decided to try Ubuntu
1 4.1 0 with varied results. The
Unity desktop froze about 1 0
seconds after loading; three
separate installs produced the
same problem. I suspect it may be
to do with the Nouveau video
driver but I never got time to
install the Nvidia driver.

I then tried with the Gnome 3
desktop, and this worked ok –
but it pre-installs many apps
which I don't like such as
Brasero and Rhythmbox. It is
also impossible to uninstall
them as they are closely tied to
the Gnome desktop, and
always warn you that they will
uninstall the desktop. There is
nothing wrong with Rhythmbox,
but I just prefer Clementine.
Brasero may be all right for
some, but, for me, in every
distro I have tested, it says I
don't have a writeable CD/DVD
– a problem I don't have with
xfburn or K3b. Also, I'm not a
fan of Gnome 3, and hated the
random distribution of icons all
over the desktop. And it would
not allow installing Calibre due

to incompatibilities with other
drivers – so this ruled it out for
me.

This is so different from
standard Ubuntu that it
deserves a completely separate
review. Of course it uses the
Last week, I impatiently opened solid Ubuntu underpinnings, so
my FCM#92 and came across a credit to the Ubuntu team, but
reference to Ubuntu with the
the end user experience is
Mate desktop. There is no
mainly due to the Mate team.
mention of this in Distrowatch
They have stuck to tried-andso I went to https://ubuntutrue applications, so everything
mate.org to find out more. It is just works as it should.
a version that emanates from
the USA. The download is only I always partition my system
983MB, but it keeps timing out before the install, and do a
so I suggest you use a torrent.
manual install to avoid any

trouble with my other
installations. Other users have
reported problems with trying
to partition via the Ubuntu
installer, but, as I had already
partitioned, I did not need to
worry about this. The install
process went off without a hitch
and took just 30 minutes. On
rebooting, the Grub menu was
the best I have ever seen, and
the visuals through the login to
the desktop showed the artistic
talent of the Mate team. I was
immediately alerted to the
availability of updates which
installed seamlessly. First
impressions last longest, and I
was impressed. Immediately
confronted with a nice blank
desktop, and all user actions
can be done via a panel and a
traditional menu; some people
would say 'old fashioned' – not
'traditional'. However, it is a
well known system which
groups all the apps in sensible
categories.
My first job was to configure to
my tastes which are based on
Mint LMDE with Cinnamon

full circle magazine #93
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desktop. The Control Centre
had a section for additional
drivers, and it automatically
selected the drivers for my
NVidia card and installed them.
My wifi drivers were installed
automatically during the setup.
It had 2 panels, but the bottom
panel held only 2 applets; I
moved these to the top panel
and removed the bottom panel.
I adjusted the width of the
panel from 24 to 32px and the
icons became huge, probably
32px. By experimentation, I
found that 31px was the
optimum size to suit my
eyesight and use the 24px
icons. It is easy to install
applets to suit most needs (and
all of mine). In addition to the
Menu Bar, I used Date, Volume,
Network, Language, Workspace
Switcher, Shut-down and Trash
applets. I also installed an
applet to display open
windows. They are all easy to
configure, although the help
option does not work, but is not
needed. The menu bar had
three categories "menu",
"system" and "places". I found

this took up too much of the
top panel, and I did not need
"places". It was easy to remove
and replace with the standard
Mate menu. A right-click
enables you to add, remove or
move any menu items. You also
have options to add an
advanced menu which includes
favourites, but needs a further
click to see all applications; it
also runs slow as it loads large
icons for favourites. It is easy to
add, experiment and remove
any of these applets.
One of my favourite add-ons is
Themes; there is a great choice
available from the Control
Centre and, coupled with a
range of beautiful wallpapers,
you can certainly find a
combination to your liking.
Now we come to the software.
Everybody has different tastes;
I like a distro to be kept lean
and let users add their
favourites later. Mate strikes a
balance supplying essentials
like Firefox, Thunderbird, Image
Viewer, Pluma Text Editor and
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Simple Scan, among others.
The only items I would like to
uninstall are Pidgin, Brasero
and Rhythmbox. Unfortunately,
all these are tied to the Gnome
desktop and cannot be
uninstalled but the menu items
can be removed. I also installed
many other apps and utilities;
they were all available in the
repositories, except grubcustomizer, and all the
dependencies were available so
I had no install problems.

menu does open on hover,
whereas the Mate menu must
be clicked. The Mate menu I
used did not have any
favourites, but I do not find this
a problem because I always put
mine on the panel.

I found one oddity with Conky
and this may be of interest to
other Conky users. I use Conky
to display system temperatures
and fan speeds on all my
workspaces by including
"own_window_type desktop" in
This is the only distro I have
the .conky.rc file and this
reviewed that I would consider normally works fine. In Mate
using instead of my
the window disappeared from
Mint/Cinnamon default.
all workspaces when I gave
Everything just works as it
focus to any desktop icon. I
should and it is blindingly fast
solved this by changing the line
with no fancy graphics. It works to "own_window_type
happily with the Nouveau
override".
drivers whereas Cinnamon and
KDE must have NVidia drivers
If you are new to Linux, and
on my machine. I like the panel looking for a productive system
because it is so easy to
that works out of the box, then
add/move/delete applets and
this is for you!
app launchers. My only gripe
with my Cinnamon desktop is
the difficulty of doing this. On
the other hand, the Cinnamon
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Written by Charles McColm

O ffi ci a l U bu n tu Book - 8th Ed i ti on

The single goal of the official book
is to make running today’s Ubuntu
even more pleasant and productive
for you.

To accomplish this goal, the
authors cover installation,
useful applications, media,
administration, Unity tips and
tricks, adding software sources,
projects related to Ubuntu, the
Ubuntu ecosystem and
community, and some serverrelated topics.
What I like about The Official
Ubuntu Book is that, while it’s
aimed at newer Ubuntu users,
Publisher: Prentice Hall (Pearson)
there is something in it for
Pages: 322
users with a bit more
Authors: Matthew Helmke, Elizabeth K.
experience. The entire book is
Joseph, José Antonio Rey and Philip
ten chapters long. The first
Ballew
ISBN-1 3: 978-0-1 3-390539-7
three chapters cover
ISBN-1 0: 0-1 3-390539-X
installation and updating your
system. Chapter four
he Official Ubuntu Book is the introduces some of the more
official Canonical-authorized
interesting applications
guide to the Ubuntu Linux
available for Ubuntu. Chapter
operating system. The eighth
five covers customizing Unity.
edition is updated to include
In chapter six the Linux
information relevant to the Long
filesystem, keyboard shortcuts,
Term Service release Ubuntu 1 4.04. personal package archives, and
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basic techniques for compiling
software are covered. It was in
chapter six where I had one of
those “hey this is cool”
moments when I came across
the proper way to remove PPAs
(funny how sites tell you how to
add them, but not remove
them), and (more cool) how to
build software from source so it
can be removed.
Part of the way I measure the
success of a course or book is
by whether or not I learn
something new that will make
me more productive. Even if a
course or book is aimed at
beginners, there’s often value
for more advanced users,
especially if the course or book
provides something that makes
you more productive. Earlier I
mentioned the single goal of
the book making Ubuntu even
more pleasant and productive,
because I found several tips
that expanded my knowledge
(in chapter six and beyond).
The Official Ubuntu Book
succeeded in filling its goal,
even though I’m not the
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intended audience.
If you’ve shied away from
learning the command line,
chapter seven provides a solid
introduction. Where many Linux
basics books cover basics such
as ls, mv, cp, more, grep and
ps, The Official Ubuntu Book
expands on these including
commands like lsb_release,
iwconfig, head and chgrp, plus
using wildcards and using
Byobu as an alternative to the
GNOME terminal.
Desktop users may want to skip
chapter 8 which covers a range
of server topics, but there’s
some coverage of RAID and
LVM that might pique the
interest of the beginner looking
for a more advanced drive
setup.
The last couple of chapters
cover community topics. To
some, this might seem like
overkill for a beginner’s book,
why the heck would a new user
care about the bazaar revision
control system or MOTUs
contents ^
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(Masters Of The Universe)?
Maybe, at the start of their
journey, a beginning user
wouldn’t care, but it’s been my
experience as a computer
refurbisher not to judge too
quickly the ability or interest of
an “inexperienced user.” I’m
often surprised by the ability
and interest of new Linux users
once they have access to
technology and information to
back it up. Knowledge doesn’t
always come right away. I recall
the time when I picked up my
first introduction to MySQL, I
got about four chapters in
before I had to put down the
book. A couple of months later
the things that didn’t make
sense to me made complete
sense, so I was glad for this
first introduction. Because
there is a great community
around Ubuntu, it’s worth
knowing about how to access
different aspects of that
community – whether it’s an
IRC channel or bug tracker.

difference. I don’t consider the
brief coverage as a bad thing
since the focus of the book is
advancing the use of stock
Ubuntu. Attempting similar
coverage for KDE, LXDE, XFCE,
MATE, Cinnamon and the
software that come with each
of the distributions would be
too much for a beginner book.
A brief introduction to each
seems just right.

It’s worth mentioning that the
first screenshot isn’t until page
44 (Chapter 2, Installing
Ubuntu). If you’re a visual
learner, The Official Ubuntu
Book has lots of screenshots,
but it’s not one of those books
that provides everything
visually; reasonable reading
effort is needed to understand
the topics presented. The first
chapter covers the Ubuntu
story so there really isn’t much
to show in the way of
screenshots/images, but it’s an
interesting read that touches
on some non-Ubuntu
The Official Ubuntu Book covers (SLS/Slackware) history and
foreshadows some of the topics
related Linux distributions:
further in the book.
Kubuntu, Xubuntu, Lubuntu,
Linux Mint, Edubuntu, etc, but
Again, for me the value of a
it’s brief coverage with no
screenshots to show the visual book or course is whether I
full circle magazine #93

learned something new that I
can use to be more productive.
This sentiment was the goal of
the book, and it succeeded in
teaching me new tricks I can
use even though I have a bit
more experience than a new
Ubuntu user. At the same time,
The Official Ubuntu Book
provides just the right amount
of information to get new
Ubuntu users off to a running
start and learn which
community resources are
available to them should they
get stuck or if they want to
participate further in the
Ubuntu community.

Charles is the author of Instant

XBMC, and project manager of a notfor-profit computer reuse project.
When not building PCs, removing
malware, and encouraging people to
use GNU/Linux, Charles works on
reinventing his blog at
http://www.charlesmccolm.com.
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Written by Knightwise.com

he black, featureless
background is broken only by
the repetitive blinking of the
amber-colored cursor. Its rhythmic
pulsing reminds that I need to
press a multitude of keys on the
keyboard to make these words
appear. Aside from a small line of
text below, informing me of how
many lines, words and characters I
have produced, there are no other
options to select, no notifications,
suggestions or other distractions.

powerful than the smartphone in
my pocket, yet I've chosen to make
it my machine of choice? Why?
Well, I have a love-hate
relationship with modern-day
computers. Their powerful CPUs
and elaborate operating systems
are the very pinnacle of our digital
existence. They come packed with
a plethora of options and
possibilities that can accommodate
our every need. That, however, is
also their undoing, in tandem with
over-connected applications and
services which want to do nothing
else than to have you either tweak
or tweet whatever you are doing ..
to the point where your
productivity is reduced to zero.
Sometimes it’s just "too much".

By modern day standards, this
application lacks a massive number
of features. No markup menu,
word suggestions, contextual
menus, or share buttons. Just
amber words on a black
background. Yet this is one of the
most productive pieces of software
That is why I took the plunge
on my computer: it lets me write
and went back to "basics" for a
these very articles.
couple of days. Using the
The computer I am running this Raspberry Pi, with its very
moderate capacity, helped me reapplication on is equally
think and re-evaluate what I really
"underpowered" by todays norm,
also underpriced! My Raspberry Pi needed to be productive.
computer with its hilariously low
The Raspbian operating system
amount of memory, CPU power
isn't packed with a lot of features,
and storage is possibly less
full circle magazine #93

just the basics to help you do what
you need to get done. There are
some applications installed, but,
when choosing extra software, you
have to keep the limited "power of
the pie" in mind. Hence, I started
thinking about what applications I
needed to be productive, and what
the minimal requirements of those
applications were.

Facebook" and get distracted. I
can't have 50 browser tabs open
because I don't have the RAM, but
that allows me to pay more
attention to the one thing I'm
researching.

In short: "Slow computing"
helps me focus. It gives me the
time to think about things before I
press another hyperlink. It is free
So, I need a browser, but does it from those over-connected
need to have 5000 extensions?
distractions, and it keeps me from
Turns out it doesn't. I need a word going down a 45-minute rabbit
processing application, but does it hole just to find the 'right
need to have 39 buttons? No, it
wallpaper' for my dual-screen
doesn't. My initial thoughts of
desktop. Sure, I'll bounce up
having my creativity seriously
against the limitations of the
curtailed by the limited powers of system... and when I do, I still have
my "simple" environment were
my other powerful laptop waiting
wrong. The simplified environment in the wings. But the amount of
and "simple" applications helped
stuff I “Get Done" before I have to
me focus more on what I needed to make that move is pretty amazing.
get done instead of getting
Slow computing helps you focus!
distracted by the tools themselves. Try it.
"Slow computing" has another
advantage. It takes my browser a
couple of seconds to start up (an
eternity compared to my other
systems), but this is a great help in
the urge to “quickly check
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If you would like to submit a letter for publication, compliment
or complaint, please email it to: letters@fullcirclemagazine.org .
PLEASE NOTE: some letters may be edited for space.

Join us on:
goo.gl/FRTMl

facebook.com/fullcircle
magazine
twitter.com/#!/fullcirclemag
linkedin.com/company/fullcircle-magazine
ubuntuforums.org/forum
display.php?f=270

FULL CIRCLE N EEDS YOU !
Without reader input
Full Circle would be an
empty PDF file (which I don't
think many people would find
particularly interesting). We are
always looking for articles,
reviews, anything! Even small
things like letters and desktop
screens help fill the magazine.
See the article Writing for Full
Circle in this issue to read our
basic guidelines.
Have a look at the last page of
any issue to get the details of
where to send your
contributions.
full circle magazine #93
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If you have a Linux question, email it to: misc@fullcirclemagazine.org , and
Gord will answer them in a future issue. Please include as much
information as you can about your query.

Compiled by Gord Campbell

Mythbuntu 1 2 on an
Q ECSI'm using
Liva. I get no audio
through the HDMI connection.

A

folder from Windows. Install the
free version of Macrium Reflect,
and tell it to save the image to z:

I suggest you browse through
How do I find the path of a
the ECS Liva reviews on
connected USB drive?
Newegg, several have suggestions.
Number one on the list is to use
In the file manager, hover
the latest kernel. There are
over
the USB drive, and the
numerous tutorials on kernel
path will appear. Another way is to
upgrades, such as
http://ubuntuhandbook.org/index. enter the command df
php/201 4/08/install-upgrade-linuxThe flash drive will appear,
kernel-3-1 6/
usually as /media/some-numbersand-letters
I'm trying to find out how to
convert my FLAC library to
I just installed 1 4.04 and if I
AAC.
watch a Youtube video on
their site, it will automatically
Use Sound Converter, which
reboot my computer 1 00% of the
you might need to install.
time. If I download the video to my
computer and play it with VLC
media player, it works fine.
I was wondering how I could
backup my Windows 8.1 to my
Using the Opera browser
home server which is running
solved the problem.
Ubuntu Server.

Q

A
Q

A

Assuming your server has
shared folders, you can assign
a drive letter (eg. z:) to a shared

Q

A
Q

A
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TOP QUESTIONS AT
ASKUBUNTU
* Delete all files apart from pdf
files in a directory
http://goo.gl/EBTQu3
* Is there a way to configure
Unity's top bar to autohide?
http://goo.gl/bZYbgP
* What is the difference between
">" and ">>"?
http://goo.gl/KdBrhE
* Search text within multiple pdfs
and docs
http://goo.gl/Cn9NSC
* Do Wine Viruses only work while
Wine is running?
http://goo.gl/1 y1 t2W
* How can one shutdown a PC
using the keyboard?
http://goo.gl/u2aiwv
* How do I regain access to my
encrypted home directory after
changing my password?
http://goo.gl/ej1 sVA
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* Allocate swap after Ubuntu
1 4.04 LTS installation
http://goo.gl/GANX5Z
* Want to disable built-in screen by
default
http://goo.gl/Q30eBR

TIPS AND TECHNIQUES
It's just not that hard

W

hen I wander around,
looking for interesting Linux
questions, it's not unusual to see
something like, "I was following
this tutorial, and had an error at
step eight (or 1 4, or 37)." Most of
the time, I say to myself, "you
should find a tutorial with fewer
steps."
This month, I fulfilled a very
complex request from my wife.
Google found the answer, and it
was five steps. (Numbers 1 and 3
would never have occurred to me.)
Some tasks really do need many
steps, but it's a lot easier if you
contents ^
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break it down into smaller chunks,
and search for how to do a chunk
at a time. "How can I build Rome"
fails, but "how can I prepare the lot
for the Coliseum" has a chance.
My favorite video editor is a
perfect example. "How can I edit
videos in Cinelerra" won't get a
useful answer, but "how can I
produce the Ken Burns effect in
Cinelerra" will find a wonderful
tutorial.
So here's my advice: if you find a
tutorial with a lot of steps, try to
break your question into a few
parts, and you will probably find
better tutorials for each part.

As a complete aside, here's a
web page I wish I had written:
http://linux.oneandoneis2.org/LN
W.htm
My favorite quote under "Linux
is not Windows," is "Linux does not
have customers."

Gord had a long career in the

computer industry, then retired for
several years. More recently, he
somehow found himself "The IT Guy"
at a 1 5-person accounting firm in
downtown Toronto.
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X- P l a n e & F S E c o n o m y

Written by Ronnie Tucker

he hardest part of FSEconomy
(FSE) is actually using the
website. What is FSE? FSE adds an
economy system to X-Plane, one
where you (initially) rent a plane,
do a job flying from A to B, and
reap the rewards. Ultimately, you
gain enough money to buy your
own plane and make even more
money. Obviously, you need to
weigh up the pros and cons of each
job. Is the plane rental so high that
it will use up most of the fee? Yes –
with a few careless jobs, you can
end up owing more money than
you actually have.

PREREQUISITES
Before installing FSE, you need
to have already installed the
Python plugin. We did this several
issues ago. So, if you haven’t done
that, now’s the time. You also need
to have Python installed on your
computer. Assuming you’ve got XPlane plugins working, then it’s
safe to assume you have Python
installed.

I NSTALLATION

Since you already know how to
install Python plugins for X-Plane,
here’s the URL for the plugin:
https://github.com/ksgy/xeconomy
Obviously, you really need only
the .PY file which, as you now
know, goes into your
.../plugins/PythonScripts folder.

/new-account). A moderator will
then create an account for you and
leave a reply saying so. You’ll also
get an email with your username
and a password, which you should
obviously change.
We’re almost there!

> New Browser Page. This will take
you to the FSE jobs page
(http://www.fseconomy.net:81 /).
So, let’s find an example job.
Click the Airport link at the top of
the page.

Here you can search for jobs by
airport,
plane, etc. I usually search
SIGN I N
for jobs using my favourite plane,
the Eclipse 550. The drop-down
Back to X-Plane; in the XTo check that it’s installed, fire
menu for choosing a plane is called
economy window, you enter your
up X-Plane and check the plugins
‘Airports that have this craft’. I click
menu. You should have an entry for FSE username and password.
Again, it’s a bit confusing as a lot of this and choose the Eclipse 500
X-economy. That’s FSE. Click it.
(next best thing).
things from the FSE site don’t
Keep the window open as we’ll
actually show up in the plugin
need to register with FSE first.
Now check the box beside that
window until you’ve either taken
drop-down menu (see image, next
off, or are half way through the
REGISTERING
job. In short, as long as it shows on page, top left). This is to show
airports with that plane for rent.
This is where it gets a bit weird. the site that you’re enroute, and
We don’t own a plane yet, in FSE,
First, you need to register with the the plugin is signed in, everything
so we need to rent one.
should be fine.
site: http://www.fseconomy.net/.
This grants you access to the site.
Finally, click GO to see the
You now need to register with the F INDING A JOB
results. You can sort the results by
forum
airport name, country, etc.
Finally! We’re at the point
(http://www.fseconomy.net/forum
where we can take a job!
/index) and leave a post in the
Let’s see. There’s one in
Game World Account Request
Benbecula (EGPL). Let’s click that
On the FSE site, go to the site
section
and see what we get.
(http://www.fseconomy.net/forum menu and choose FSE Game World
full circle magazine #93
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Before looking at those jobs,
scroll down a bit to see how much
the rental is going to be (see image
below).
Ouch! That’ll be $751 per hour
wet. Wet means it’s filled up and
ready to take off. So, we need to
look at the jobs and try to get one
that’s worthwhile.
I like to sort the jobs by NM
(Nautical Miles) as I don’t want one
that’s too long.

and dark (everything off).
Sometimes I have to press ‘V’ for
parking brakes.
minutes, then you’d only use about
$350 for rental and the rest is
yours.

you have a plane with 33% fuel
(enough for the job) and that the
job is ready to depart.

To take the job, click the
checkbox beside the job and click
the button (below the jobs) which
says ‘Add Selected Assignments To
->’ and the drop-down menu beside
it should say ‘My Flight’. The page
will reload and the job you chose is
now not listed – as you’ve taken it.

Jump back to X-Plane and make
sure you’re signed in to the Xeconomy plugin and click the Start
Flying button. It may show the job
details right away, or it might show
them only once you take off. The
plugin is a bit weird like that.
Reload the FSE site and it should
say that you’re enroute.

Scroll down to the aircraft and
click the ‘Rent Wet’ beside the
plane you want. The Eclipse 500 in
my case. OK. You’ve got a job and a
plane. Click ‘My Flight’ at the top of
the page.

Let’s say we want the ‘3
Benbecula Nurse’ job (shown
above right). Which pays $1 ,1 32.
Remember that if it takes you one
This page shows you the job
hour to do the job (and it shouldn’t,
details. That you’re departing from
not for 27 NM), then you’d be left
with about $400. If it takes only 30 EGPL to EGPR, it’s 27 NM, and that
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Head back to the FSE jobs page
and look at the top right of the
page. Up there it should show your
current balance.

Fly safe!

Anyway, complete the job. Put
Credit must go to Dick Thomas
the brakes on and switch your
for showing me how to use the
engines off. If all has gone well Xhighly unintuitive FSE site.
Plane should pop up with a
message saying that the job is
complete. I found that this can
sometimes need only the brakes on
to complete the job. Sometimes
you need to have the plane cold
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U n i g i n e H e a ve n B e n c h m a rk

Written by Oscar Rivera

S

o now that 201 4 is behind us,
we can reflect back on how
great of a year it was for Linux
gaming. The gargantuan number of
games added to the Linux gaming
library, combined with the
constantly increasing rate at which
games continue to be added, is
allowing many dual-boot users to
nuke their Windows partition which
they've kept around for the sole
purpose of gaming.
So with all of these games
available now, is your system ready
to play the latest AAA game that
you've been waiting for? Well,
you'll be pleased to know there's a
way to find out. I've been writing
the video game column for FCM for
well over a year now and often I
have to rely on published
benchmarks to be better informed
about the games I play and/or
review. For the most part, my CPU,
HDD, RAM and latest Ubuntu LTS is
up to par when it comes to playing
today's games, and I believe it's the
same for most readers. However,
when it comes to the graphics card
and its GPU, that's where some of
us may not have what's required to

play that game we've so patiently
been waiting to be released. So,
I've been wondering, is there
reliable gaming benchmark
software for Linux that I can use to
find out how well my system will do
against the latest and most
demanding video games? I set out
on a mission to find the easiest and
most reliable benchmark software
for Linux.
Although it's proprietary and
not the easiest to install on Linux,
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Unigine's Heaven Benchmark is
cross-platform, and as such it is
perhaps the single most used
benchmark application. Unigine's
Heaven Benchmark is available for
Windows, Mac OS X and Linux. As I
stated earlier, the installation is a
more involved process on Linux
than it is for Windows or Mac. After
finding a few websites with very
different instructions on how to
install and how to run it, I
succeeded in installing and running
Heaven while at the same time
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avoiding any major disasters.

I NSTALLATION
The most difficult aspect of
using Unigine Heaven 4.0 for me
was getting the software installed.
Unfortunately, Unigine Heaven is
not available in any of Ubuntu's
official repositories, which means I
had to go to
https://unigine.com/products/heav
en/ to download the installer
package. At Unigine's website,
you'll find three options: Basic
Edition which is free, Pro Edition or
Advanced Edition. There's also a
chart comparing the differences
between all three editions.
For the purposes of this article,
and for what I need to get out of it,
the Basic Edition will suffice. The
Advanced Edition costs $1 4.95,
while the Pro Edition costs $495.
The average person who needs to
just benchmark their system will
need only the Basic Edition. The file
that gets downloaded is named
Unigine_Heaven-4.0.run, and it's
about 280 MB in size. Having
downloaded the installer, you'll
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need to change its permissions to
allow it to be run as an executable
file, and maybe change a line of
script if you're using a 64-bit
system. There's a good set of
instructions at:
http://ubuntuxtreme.com/howto/h
ow-to-run-unigine-heaven-3-0-inubuntu-1 2-04-64bit/3/, but keep in
mind to change 'Unigine_Heaven3.0' for 'Unigine_Heaven-4.0 as you
follow the instructions since the
version you'll most likely be
installing is 4.0 and not 3.0 (which
is an older version). I found another
great set of instructions at
http://ubuntuforums.org/showthre
ad.php?t=21 44692, and, in the end,
I ended up using a little bit of both
in order to get Heaven up and
running in my system. When it was
finally installed, I couldn't get the
software to run at all. I had to
change directory to my Downloads
folder (where I had installed
Heaven), and I was able to run the
software from a terminal:
cd
~/Downloads/Unigine_Heaven4.0
./heaven

O PTIONS AND RESULTS
Some of you might be

Stereo 3D, Multi-monitor, Antialiasing, Full-Screen and
Resolution. Then, below all of
these choices there's a button
labeled “Run” which you should
press when you're ready to run the
benchmark. The benchmark itself is
quite beautiful...

wondering what the purpose is
behind running benchmarking
software like Unigine's Heaven.
There are many benefits to getting
your hardware benchmarked
properly. As far as video gaming is
concerned, for people who play
their games on consoles such as
Playstation 3/4 or XBox360/XBox
One, it's a reassuring feeling
knowing that the game that they
just bought will play on their
console of choice without any
problems, without any lag, and
with the best graphics possible. For
those of us who game on our
computers, we have zero
reassurance that any game we just
bought (or are thinking of buying)
will even be playable. The results of
full circle magazine #93

a properly benchmarked computer
will give us a good starting point
for what kind of games will play
smoothly with maximum settings,
minimum settings, or not play at
all.
The user interface for Heaven is
windowed and fits in about a third
of my desktop space. One of the
options on the interface, before
you actually begin running the
benchmark, is whether you want
the benchmark to run in windowed
mode or full-screen. Since I play
99.9% of my games full-screen, it
would make sense to run Heaven
only full-screen, which is what I did.
Some other choices you have are
Language, Quality, Tessellation,
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There's a floating town, with a
dragon in the middle of the town
square, and you get a 360º view of
the dragon as well as the entire
town before heading up into a sort
of zeppelin in the sky. You can hit
'Run' and simply enjoy the graphics
and music that accompanies it, but
when you're ready to actually
benchmark your system and get
some results, you'll need to use
your mouse and go to the top-left
corner of the screen and click on
the button that says 'Benchmark'.
The benchmark will run, and give
you its results when it's finished.
The entire benchmark consists of
26 scenes – which you can keep
track of in the bottom-right corner
while the actual benchmark is
being run. On the top-right corner,
you'll see some information about
your system, such as what graphics
card you have, how much of its
memory it's currently using, and its
current temperature (which, by the
way, is changing as the benchmark
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keeps running its course). You can
also see how many frames-persecond (FPS) your system is
pushing out during the running of
the benchmark. At the bottomright corner of the screen (and this
is only visible after you've clicked
on the 'Benchmark' button), you
see some additional information
about the benchmark such as how
long the benchmark has been
running (Time), frames, minimum
frames-per-second, maximum
frames-per-second, and your
current score. As long as you're not
overheating your graphics card,
you should try to let the entire
benchmark run its full course in
order to get the most accurate
results. When the benchmark is
done, then the final score results
screen will appear, and it will give
you the option to save your results
in HTML form. In addition to saving
your results, I recommend taking a
screenshot of the results screen.
The reason I suggest taking a
screenshot of the score screen is
that if you want to compare your
result and post it up on the web,
some forums require that you post
a screenshot of your results to
verify that you actually ran the
benchmark. One of the websites I
went to, techpowerup, has a list of
results which I'll be using to figure

out which graphics card I should
consider upgrading to, especially
since my results are better than
some of the newer graphics cards
that I saw posted.

• GPU:

• ATI Radeon HD 4xxx and higher
• Nvidia GeForce 8xxx and higher
• Intel HD 3000 and higher

Seagate Barracuda hard drive. The
software used was Ubuntu 1 4.04.1
LTS, with Unity desktop and AMD
1 3.9 proprietary graphic drivers.

• Video Memory: 51 2 MB
• Disk Space: 1 GB
• For hardware tessellation, both a CONCLUSION
video card with DirectX 1 1 /OpenGL
SYSTEM REQUIREMENTS
4.0 support and MS Windows
Except for the difficulty that
Yes, believe it or not, there are Vista/7/8 or Linux are required.
most Linux users will encounter in
minimum system requirements for
order to install Unigine Heaven,
Heaven Benchmark; after all, you
every other aspect of this
M Y SYSTEM
need to have at least a semi-decent
benchmark gets a nearly perfect
system to play games, right? One
score. The scenes through which it
I ran the Unigine Heaven
thing the website doesn't tell you
Benchmark with my custom-made runs are beautiful, and a great way
is that you'll need a proprietary
for you to really see what your
desktop PC consisting of an AMD
graphics card to run Heaven.
FX-61 00 3.3GHz CPU (overclocked graphics card is capable of. In
addition, it also shows you the FPS
to 3.5GHz), an Asus M5A97-EVO
This is what's shown on the
(frames-per-second) while it's
motherboard, a Sapphire Radeon
Unigine Heaven products page:
running, and your graphics card's
HD 5770 graphics card, 8GB of
information (including its
Kingston Hyper X RAM, and a 1 TB
temperature). The results at the
end make it indispensable for all of
us Linux gamers.

Oscar graduated from CSUN, is a

Music Director/Teacher, beta tester,
Wikipedia editor, and Ubuntu Forums
contributor. You can contact him via:
www.gplus.to/7bluehand or email:
www.7bluehand@gmail.com
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M Y D E S KT O P

Your chance to show the world your desktop or PC. Email your screenshots and
photos to: misc@fullcirclemagazine.org and include a brief paragraph about your
desktop, your PC's specs and any other interesting tidbits about your setup.

syncronize my Google Drive
folder using the Insync
addin.
Variety http://peterlevi.com/variety
Digital Blasphemy http://www.digitalblasphem
y.com

Gar Nelson

M

y system is an older Shuttle
Glamor XPC, with a dual DVI
graphics card installed. The
monitors are two Samsung 24"
HDMI monitors, each set to 1 920 x

1 080, for a total of 3840 x 1 080. (I
also use DVI to HDMI adapter
cables.) The O/S is Ubuntu 1 4.04
LTS, and I run Variety to put a large
clock, and random quotes on a
full circle magazine #93

sequence of Digital Blasphemy
wallpapers. I use the Oxygen icon
theme, and a redglass cursor. I
syncronize my Dropbox folder
using the Dropbox addin, and
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MY DESKTOP

H

ello, I’m a Lubuntu user. I have
been using Ubuntu since
elementary school. I make my
Lubuntu more comfortable for my
netbook with my custom kernel
optimized for netbook.

My Netbook Spec :
Proc : Intel Atom N270 1 .6 GHz
RAM : 1 GB DDR2
Storage : Sandisk Cruzer Blade 8 GB
Using Lubuntu 1 4.04
full circle magazine #93
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H O W TO CO N TRI B U TE

Full Circle Team

FCM#89

FULL CIRCLE NEEDS YOU!

A magazine isn't a magazine without articles and Full Circle is no
exception. We need your opinions, desktops, stories, how-to's, reviews,
and anything else you want to tell your fellow *buntu users. Send your
articles to: articles@fullcirclemagazine.org

Deadline :

Sunday 08th Feb. 201 5.
Release :
Friday 27th Feb. 201 5.

We are always looking for new articles to include in Full Circle. For help and advice please
see the Official Full Circle Style Guide : http://url.fullcirclemagazine.org/75d471
Send your comments or Linux experiences to: letters@fullcirclemagazine.org
Hardware/software reviews should be sent to: reviews@fullcirclemagazine.org
Questions for Q&A should go to: questions@fullcirclemagazine.org
Desktop screens should be emailed to: misc@fullcirclemagazine.org
... or you can visit our forum via: fullcirclemagazine.org

Editor - Ronnie Tucker
ronnie@fullcirclemagazine.org
Webmaster - Rob Kerfia
admin@fullcirclemagazine.org
Podcast - Les Pounder & Co.
podcast@fullcirclemagazine.org
Editing & Proofreading
Mike Kennedy, Gord Campbell, Robert
Orsino, Josh Hertel, Bert Jerred, Jim
Dyer and Emily Gonyer
Our thanks go to Canonical, the many
translation teams around the world
and Thorsten Wilms for the FCM logo.

Getting Full Circle Magazine:

EPUB Format - Recent editions of Full Circle have a link to the epub file on the downloads page. If you have any problems with
the epub file, you can drop an email to: mobile@fullcirclemagazine.org

Issuu - You can read Full Circle online via Issuu: http://issuu.com/fullcirclemagazine. Please share and rate FCM as it helps to
spread the word about FCM and Ubuntu Linux.

Google Play - You can now read Full Circle on Google Play/Books. Either search for 'full circle magazine' or
click this link: https://play.google.com/store/books/author?id=Ronnie+Tucker
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